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V9054 VXI Spectrum Analyzer 

Technical Manual 

Morrow Technologies Corporation 
2300 Tall Pines Drive 

Largo, FL 34641 
Phone: 813-531-4000 Fax: 813-531-4026 

V9054 Spectrum Analyzer Overview 

Introduction 

The V9054 Spectrum Analyzer from Morrow Technologies now gives VXIbus integrators access 
to a full-functioned 1.6 GHz spectrum analyzer. In addition to being the first VXI spectrum 
analyzer, the V9054 also provides a combination of innovative hardware and software features 
that further benefits spectrum analyzer applications. 

First, unlike traditional spectrum analyzers, the V9054 maintains precise frequency accuracy at 
all points in a sweep . This is accomplished with fully synthesized tuning which locks the 
synthesizer to the reference oscillator at each point in a sweep. Since the instrument sweeps by 
making many small steps, every point returned by the instrument will be as accurate in frequency 
as the reference oscillator. 

Next, the V9054 has virtually no limit on the number of points that can be returned from a 
sweep. Instead of just a few hundred points that are available from a traditional analyzer, the 
V9054 has the capability to deliver tens of thousands of points from one sweep. Thus, instead of 
searching for signals with a wide sweep and then making narrow sweeps to resolve details, the 
V9054 can capture the details in one wideband sweep. An added benefit is that each of the 
points in the sweep has precise frequency accuracy. 

Nonlinear sweeps are another unique capability provided in the V9054. Users can download the 
instrument with a table of frequency points which allows it to jump directly to frequencies of 
interest. For instance, when testing the harmonic content of a signal, the V9054 can be set up to 
jump only to the frequencies of the harmonics and avoid a slow wideband sweep. Using this 
feature in automated test systems can dramatically reduce the time it takes to perform tests. 
Also, this directed search capability can be very beneficial in spectrum surveillance applications. 
In many VXI applications the V9054 may also be suitable for performing the functions of 
multiple instruments. For instance, in a communications test set the V9054 could serve as a 
spectrum analyzer, power meter, frequency counter, and a modulation meter. 
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Hardware 

The V9054 is composed of four main sections: a synthesizer, RF chain, video processor, and a 
digital controller. The RF chain uses triple conversion to convert the input signal to a final I.F.. 
frequency of 10.7 MHz. The first mixer is preceded by a fixed low pass preselection filter and a 
0 to 60 dB stepped attenuator. High quality mixers and filters are used throughout the RF chain, 
as well as low noise amplifiers. The resulting circuit provides a noise floor of less than -120 
dBm, a third order intercept of 5 dBm, and a third order dynamic range of greater than 80 dB 
over the 1600 MHz input frequency range. 

The third I.F.. is further processed by resolution bandwidth filters. The RBW filters are 
implemented as 4-pole synchronous filters to minimize settling time as the engine sweeps. The 
bandwidth of the filters ranges from 300 Hz to 3 MHz. 
The synthesizer produces the three local oscillator signals for the RF chain. Each of the local 
oscillators is locked to a precise TCXO (or optional OCXO) 10 MHz reference oscillator. The 
second and third local oscillators are fixed in frequency while the first local oscillator provides 
all the tuning for the instrument. 

The first local oscillator has a main phase-locked loop that combines the outputs of three sub- 
loops and a direct digital synthesizer. The multi-loop design provides a wide band, low phase 
noise synthesizer which settles in approximately 100 microseconds and has a 1 Hz step 
resolution. 

The video processor includes the log detector, linear detector, video bandwidth filters, and a high 
speed, 12 bit analog-to-digital converter. In addition to digitizing the amplitude of the detected 
signal, the converter can also be used to directly digitize the third I.F.. signal. 

The digital controller has two microprocessors and two digital signal processors to communicate 
with the VXI bus and control the other sections of the instrument. One microprocessor interprets 
the commands from the VXI bus. The other microprocessor and a digital signal processor 
control the internal functions of the V9054, including control of the synthesizer and calibration. 
The second digital signal processor is available to perform various DSP algorithms such as FFTs 
and digital filtering. User-defined algorithms can be downloaded into this processor. 

The V9054 is packaged as a two slot "C" size VXI module. A machined housing and innovative 
shielding and grounding techniques are used to achieve sufficient isolation between both the 
instrument's own internal modules, and between the instrument and other VXI modules. 

Calibration 

The V9054 is calibrated at over 12,000 different combinations of input frequency, reference 
level, RBW, VBW, etc. These calibration points are maintained in nonvolatile memory and are 
used by the instrument to accurately adjust the amplitude of the points returned in a sweep. This 
extensive amplitude correction technique is possible because the frequency is precisely known at 
every point in a sweep. Thus for every frequency step in a sweep the instrument looks up the 
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nearest calibration point and makes an amplitude correction. 

Software 

An integral part of any VXI instrument is the software. The V9054 provides a powerful array of 
software tools for spectrum analysis and application development. While the greatest number of 
tools exist for the Microsoft Windows environment, strong support is available for DOS and 
UNIX systems as well. 

Many VXI applications are highly specialized and tend to require custom features. Thus, system 
integrators often face some degree of programming for VXI instruments. To meet these needs, 
the V9054 provides a number of software options for creating custom applications. The first of 
these is the V9054 C Programming Library. This C language application programming interface 
(API) provides complete control of the V9054 hardware to any C program. 

This same API is also available as a Windows dynamic link library (DLL). This allows 
Windows programmers to control the V9054 from C/C++, Visual Basic, or any other DLL- 
capable Windows application. Virtually any application can be designed using this library, 
regardless of size or complexity. In addition, Morrow Technologies will provide 
LabWindowsICVI and LabView instrument drivers. This makes the V9054 even easier to 
integrate with other VXI test instruments. 

The V9054 C Library Function Tree 

The C Library function outline is shown below as a "tree" of functions and their descriptions 
grouped with respect to the operations they perform. This is the set of functions available in the 
Morrow Technologies V9054 C Library and provides complete control of the V9054 hardware 
and all of its capabilities. 

Function Operational Description Function Name: 

Configuration Functions 
Bardware Configuration 

Set Interrupt Code 
Read Interrupt Code 
Set IRQ Number 
Read IRQ Number 
Set Address Port Number 
Read Address Port Number 

Attenuation Functions 
Set Attenuator Value 
Read Attenuator Setting 
Set Input Reference Level 
Read the Input Reference Level 

Detector Mode Functions 
Set Linear Detector 
Set Log Detector 
Set 3rd IF Detector 
Read Detector Mode 

Trigger Mode Functions 
Set Trigger Mode 

SetIntrCode 
RdIntrCode 
SetIrqCRm 
RdIrqNum 
SetPortNum 
RdPortMun 

SetAttenuatr 
RdAttenuatr 
SetRefLevel 
RdRefLevel 

SetDetectLin 
SetDetectLog 
SetDetect3IF 
RdDetect 
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Read Trigger Mode 
Set Trigger Frequency 
Read Trigger Frequency 
Set Trigger Threshold 
Read Trigger Threshold 

Cell Mode, Dwell Time Functions 
Set Auto Cell 
Read Auto Cell 
Set Cell Mode 
Read Cell Mode 
Read Cell Point Frequency 
Set Number of Cells 
Read Number of Cells 
Set Sweep Code 
Read Sweep Point Frequency 

Frequency Hop Functions 
Set Hop Table Count 
Read Hop Table Count 

Resolution Bandwidth Functions 
Calculate RBW Code 
Set RBW 
Read RBW 
Set RBW Mode 
Get RBW Wide 

Video Bandwidth Functions 
Calculate VBW Code 
Set VBW 
Read VBW 
Set VBW Mode 
Get VBW Wide 
Set Filter Ratio 
Read Filter Ratio 

Sweep Functions 
Set Start Frequency 
Read Start Frequency 
Set Stop Frequency 
Read Stop Frequency 
Step Size Mode 
Set Default Points 
Read Default Points 
Set Number of Sweep Points 
Read Number of Sweep Points 
Set Step Size 
Read Step Size 

Sweep Time Functions 
Sweep Time M ~ d e  
Set Sweep Time 
Read Sweep Time 
Override Settling Time' 
Read Settling Time 
Set Dwell Time 
Read Dwell Time 
Default Settling Time VBW 
Default Settling Time RBW 

Zero Span Functions 
Set Zero Span Sample Count 
Read Zero Span Sample Count 
Set Zero Span Sample Rate 
Read Zero Span Sample Rate 
Set Zero Span Frequency 
Read Zero Span Frequency 

Action/Status Functions 
Action Functions 

Initialize Engine 

RdTrigMode 
SetTrigFreg 
RdTrigFreg 
SetTrigThrsh 
RdTrigThrsh 

SetHopTabCnt 
RdHopTabCnt 

CalcRBWCode 
SetRBW 
RdRBW 
Set RBWmode 
Get RBWwide 

SetStartFreg 
RdStartFreg 
SetStopFreg 
RdStopFreg 
StepSizeMode 
SetDefltPts 
RdDefltPts 

SwpTimeMode 
Set SwpTime 
RdSwpTime 
OverrideSetTime 
RdSettleTime 
SetDwellTime 
RdDwellTime 
DefltSetTimeVBW 
DefltSetTimeRBW 

InitEngine 
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Break Sweep 
Start Sweep 
Start Frequency Hop 
Start Zero Span 
Load Frequency Hop Table 
Shut Down Engine 

Status Functions 
Is Calibrated 
Is Sweeping 
Check For Min/Max Mode 
Check for Frequency Data Mode 

Data Functions 
Acquisition Functions 

Get Spectrum Data 
Get Trace Data Only 
Get Trace Data with Frequency 
Get Min and Max Data Points 
Get Min, Max and Freg data 

Data Conversion Functions 
Get dBm for Amplitude 
Get nano Volts for Amplitude 
Get nano Volts for dBm 

Data Analysis Functions 
Find High Peak 
Find Next Peak 
Find Point at Sweep Frequency 

Utility Functions 
Initialize Instrument Data 
Reset Engine 
Re Couple (Engine calibration) 
Delay Operations 
Copy 9052 Structure 

Close 

Breaksweep 
Startsweep 
StartFregHop 
StartZspan 
LoadHopTable 
ShutdownEngine 

Iscalibrated 
Issweeping 
CheckForMinMax 
CheckForFreggts 

GetSpectrumData 
GetTraceData 
GetTraceWithFreg 
GetMinMaxData 
GetMinMaxWithFreg 

Get DbmForAmpl 
GetnVForAmpl 
GetnVForDbm 

InitInstrData 
ResetEngine 
Recouple 
DelayOps 
Copy9052Struct 
Close 
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V9054 Hardware Orientation 

Hardware Installation 

Insure that the power to the chassis is off. 

Set the logical address of the V9054 before placing it into your VXI chassis. You will 
find a red bank of slide switches at the rear of the spectrum analyzer for this purpose. All 
V9054s are shipped with all these switches in the OFF position which produces a logical 
address of 255. An address of 255 is a special case which indicates that the resource 
manager software will assign a logical address to the device. If you do not want the 
address assigned automatically, set the switches to a binary value other than 255 or 0. 
The 0 address is the other special case in that the chassis controller reserves address 0 for 
itself. 

Now, hold the spectrum analyzer with the face toward you and with the product label 
lettering oriented upwards. The blue Morrow Technologies ejector handle should now be 
at the top fiont of the spectrum analyzer. 

Select a pair of adjacent slots in the VXI chassis for the spectrum analyzer to occupy. 
Note the controller requires that it be inserted into the leftmost slot numbered 0. 
Obviously you should avoid placing the V9054 in the 0 slot. You will notice that each 
slot has an upper and lower guide rail in which there is a groove. You must insert the 
spectrum analyzer such that the green circuit board, visible fiom the top and bottom of 
the V9054, fits into the upper and lower grooves. Only with the circuit board in both the 
upper and lower grooves will the connectors on the rear of the spectrum analyzer fit into 
the connectors on the chassis back plane properly. 

Slide the unit carefully along its guide rails to the back of the chassis. A slight amount of 
pressure may be necessary to insert the connectors at the back of the unit into the chassis. 
If excessive force is required, check to see that you are properly on the guide rails. 
Applying undue pressure to a misaligned connector could cause damage to the V9054. 
When the unit is secured in the chassis, the ejector handles should click into place. 

Power Up 

When the chassis is first powered up, the top LED on the V9054 should light for a short time and 
then turn off. At this point, only the fourth LED, "Trigger", should be lit. If the LEDs are not in 
this state after a couple of seconds, perform the following corrective actions. 

Turn the chassis power off 
Insure proper insertion of all devices. 
Power the chassis back up. If the problem persists, contact Morrow Technologies 
technical support for help. 
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1 

The V9054 Front Panel 

The V9054 front panel has 3 main features: 8 LED indicators; 8 SMA type inputloutput 
connectors; and 2 ejectors, shown at the left top and bottom comers. These interface features are 
described in detail below. 

Removing the V9054 

To remove the spectrum analyzer, push the top ejector knob toward the top the chassis, and push 
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the bottom knob toward the bottom of the chassis. To clarify, place a finger on the bottom of the 
top knob, and place another finger on the top of the bottom knob. Now push the ejector knobs 
away from each other. Finally, slide the unit along the guide rails until it is free of the chassis. 

V9054 External Connectors 

To operate your spectrum analyzer you will need to use at least one of the connectors which 
project from the spectrum analyzer through the back of your PC or the front of your VXI chassis. 
Figure 1 below identifies the V9054 external connectors and figure 2 identifies the V9054 
external connectors. 

Note: optional ports include L. 0. I Input, Tracking Generator Output, and Gated Trigger 
Output 

Of the ten possible connectors only the RF Input connector must be used to operate the spectrum 
analyzer. The L.O. 1 output connector should be terminated in a 50 Ohm impedance. 

To operate the spectrum analyzer, you must connect a signal to the RF Input connector. Use of 
any of the other input or output connectors is optional. Below is a brief functional description 
for each connector. 

L.O. 1 Out 

This signal is produced by the first local oscillator synthesizer. I t  is required 
for the optional tracking generator. The frequency of this signal is equal to 
the input frequency in MHz plus 2050 MHz. The level is typically +6 dBm. 
During the normal instrument operation this connector must have a 50 Ohm 
terminator installed. 

External Reference Input 

Use this input when you wish to use a 10 MHz high precision reference other 
than the internal reference. The external reference should be a sine wave with 
a level of 0 to +4 dBm. 

10 MHz Reference Output 

You may use this sine wave output signal to drive the external reference 
inputs of any other devices in the system. The standard OCXO (oven 
controlled) reference oscillator has an accuracy of 5x10-7, and the optional 
TCXO (temperature controlled) reference has an accuracy of 5x10-8. 
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External Trigger In 

Using this TTL level input allows the spectrum analyzer to start collecting 
data when the logic of the External Trigger reaches some pre-defined logical 
state. For example, the V9054 can be setup to start collecting data when the 
External Trigger In signal goes high, or the sweep may be setup to collect data 
when the trigger signal is low. This trigger may also be set for rising or falling 
edge sensitivity. 

3 r d I  F Out 

This output reflects the input signal at the intermediate frequency 10.7 MHz. 

Demod Out 

The demodulation output is produced by the log and linear detectors. The 
output signal from the detector is first processed by the VBW filter before 
reaching this connector. The DEMOD OUT level is 0 to +I Volt full scale. 

RF Input 

This is the only required connection when measuring a signal. Without an 
input signal the collected data reflects only the spectrum analyzer's internal 
noise floor. 

Input Signal Limitations 

e DO NOT apply more than +20 dBm to the input connector because this will damage 
, - 

your spectrum analyzer. 

DO NOT connect a DC power source to the input connector because this will damage 
your spectrum analyzer. 

I>O use input signal sources with 50R characteristic impedances to obtain the most 
accurate readings. 
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V9054 Spectrum Analyzer LEDs 

The V9054 Spectrum Analyzer is equipped with eight LED's to indicate the status of the . 

spectrum analyzer. Next to each LED on the face plate of the V9054, each LED's function is 
labeled. What follows here is a discription of each LED based on its label name. 

Name 
FAILED 

MODID 

Description 

This LED is linked directly to the SysFail* line on the VXI bus. If this LED is on, the entire 
VXI bus needs to be reset; usually the 0 Slot Controller has a reset button to accomplish this. 
You, also, may notice the Failed light flash after reset or power on; this is a result of the VXI 
defined hard reset-power on procedure. 
Connected to a VXI bus line that is used only during setup by the Resource Manager, this 
LED should be off at all times except during a short period during logical address 

ACCESS 

TRIGGER 
STATO-STAT3 

configuration (you may, in fact, not even see it flash.) 
This LED is extremely useful for diagnostics during programming. This LED will light when 
data is read or written to the VXI registers present on the Spectrum Analyzer. Following the 
communications protocols listed in the Programmer's Guide to the SA9054 Spectrum 
Analyzer the Access LED may remain on for long periods of time if the V9054 is not 
responding. This is due to the host software continually polling the specturm analyzer for a 
successful error code. 
This LED currently is unused, and it is on at all times. 
These LED's are unused, and they are off at all times 
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A Brief V9054 Operations Guide 

This guide presents an introduction to how the V9054 conducts spectrum analysis. The V9054 
has much in common with most spectrum analyzers on the market, but there is also much which 
is unique. Having an understanding of how the V9054 operates will help you make 
measurements and take advantage of strengths of its design. 

The V9054 is a super-heterodyne spectrum analyzer. This means that the instrument examines 
frequencies by mixing the input signal with a signal from an internal oscillator. This oscillator is 
referred to as the first local oscillator (L.O.) and the V9054 generates it in a unique manner. Most 
spectrum analyzers utilize a free sweeping oscillator (VCO or YIG) which is phase locked at its 
start frequency or perhaps its center frequency. The V9054's synthesizer instead takes discrete 
frequency steps, and is phase locked at each of those steps. This allows the V9054 to step 
directly to any frequency within its bandwidth and it locks that frequency to its internal reference 
in 120 us. The fast step time and design of the V9054's synthesizer allows the V9054 to hop 
directly forward or backward to frequencies of interest. 

Warm-up Time 

1 You need to let the spectrum analyzer warm-up before use. After powering up at room 
I temperature the V9054 will be operational in less than five minutes and will meet all 

specifications within fiReen minutes. This time allows the V9054's components to reach each 
their individual operating temperatures. In particular the reference oscillator needs to be heated 
to a specific temperature before it will output the correct frequency. If you attempt to use the 
spectrum analyzer before this oscillator has reached its operating temperature you may observe 
your signal "jumping" in frequency and amplitude. This is normal. If you observe the signal 
while the spectrum analyzer warms up you will see the signal stabilize over a short period time. 
When the signal becomes stable the oscillator has reached its operating temperature, but if fifteen 
minutes have not yet elapsed the amplitude and frequency reported may be slightly out of 
specification due to instability in the temperatures of the components as a whole. Thus, before 
taking any new measurements it is best to measure a signal of known frequency and amplitude. 

- In this way you can verify that the spectrum analyzer is reporting correct values. However, you 
may be sure that after fifteen minutes have elapsed that the spectrum analyzer is reporting correct 
values without bothering to verify with a known signal. The amount of warm up time does vary 
with the ambient temperature. Particularly if the temperature is colder than normal you will 
observe that more warm-up time is required. 

Sweeping 

The primary function of a spectrum analyzer is to measure the signal amplitude in the frequency 
domain. The frequency range examined is determined by the output of the first L.O. that, as 
already mentioned, is normally generated from a ramped or swept frequency source. Thus the 
process of examining a frequency range is often referred to as "sweeping" the frequency 
spectrum. Although, the V9054 executes a "sweep" by taking many finely tuned, discrete 
frequency steps, the speed of the V9054's synthesizer results in sweep times very similar to the 
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traditional method. However, the V9054 achieves far greater frequency accuracy, and has the 
added ability to execute nonlinear frequency scans. 

As the paragraph above states, the V9054 takes many frequency steps to examine a frequency 
range. The number of steps taken depends on the desired search range, and the desired 
resolution of the resultant spectral data. The width of frequency range under examination is 
known as the current span of the instrument. Thus if the V9054 is currently examining the 
frequency spectrum ranging from 88 MHz to 108 MHz (the FM band) the span would be 20 
MHz. The number of synthesizer steps the V9054 will take to examine a 20 MHz span depends 
on the selected RBW filter and would be between 20 steps (for a 3 MHz RBW) and 200,000 
steps (for a 300 Hz RBW.) 

Filters 

After determining the range of your sweep, you will want to choose settings for the two types of 
filters available. The choices you make will affect the appearance of your signal, and the amount 
of time each sweep requires. The two filters you may set are the Resolution Bandwidth Filter, 
RBW, and the Video Bandwidth Filter, VBW. 

RBW 

You may choose to let Giselle select the RBW for you automatically or, you 
may choose from one of 5 RBWs that are designated 300 Hz, 3 KHz, 30 KHz, 
300 KHz, and 3 MHz. Each filter is specified by a frequency that is called the 
filter's bandwidth. RBWs with smaller bandwidth's are called narrow or slow 
RBWs, and similarly filters with larger bandwidths are called wide or 
fast. 

I I 

Figure 1 - This image contrasts the appearance of the same signal viewed with 
different RBW filters. 

Each name offers a different perspective on the effects of a particular filter on 
your sweep. For example, the 300 Hz RBW will produce a narrower trace of 
your signal than the 3 KHz RBW, and the 300 Hz RBW will also produce a 
slower sweep than the 3 KHz RBW (if effects of the VBW are ignored, see 
below.) Below is an example of how the same signal would look if it were 
swept using the 300 Hz filter and the 3 KHz filter. 
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As you can see the chosen RBW has a profound effect on the appearance of the signal. 
Choosing the next highest RBW (lox the current RBW bandwidth) will cause the apparent width 
of the signal to increase about 10 fold. More than just a matter of appearance, however, the 
width of the signal determines how well two signals with similar frequencies are separated (if at 
all) on the display. That is, the narrower the RBW the more noticeable the separation of two 
signals; Figure 2 below illustrates this point. 

I I 

Figure 2. The selected RBW determines the ability of the V9054 to resolve 2 closely spaced 
signals. 

It would be difficult to distinguish the two signals using the 3 KHz RBW, however the two 
signals when viewed using the 300 Hz RBW are completely separated. This effect is called 
resolution, and it gives the RBW its name (Resolution Bandwidth Filter). Two signals are said to 
be resolved if using a particular filter it is possible to tell that there are two signals present. If in 
the above example the 30 KHz RBW had been used instead of the 3 KHz RBW, the two signals 
would have appeared to be a single signal and thus would have been unresolved. The bandwidth 
of a filter tells you the minimum width of any signal on the display, so to view two signals of 
equal amplitude whose center fi-equencies are f Hz apart you can not use a RBW with a 
bandwidth less than f Hz. For instance, if you would like to view two signals whose center 
frequencies you know to be 50 KHz apart, you would not be able to use any filter larger 50 KHz 
because the signals would not be resolved. 

The RBW helps to determine the time it takes for a sweep to complete. Narrow RBWs take 
longer at each frequency in the sweep to obtain a stable amplitude reading, and thus narrow 
RBWs cause slower sweeps. The time spent at each frequency is called the RBW's settling time. 
A full explanation of sweep time including the effects of the RBW, VBW, and synthesizer is 
offered in the section Sweep Speed below. RBWs with more narrow bandwidths require more 
time to settle than those with comparatively wide bandwidths.. 

VBW 

The Video Bandwidth Filter is used to reduce or eliminate noise on your 
signal. The seven VBWs (3 Hz, 30 Hz, 300 Hz, 3 KHz, 30 KHz, 300 KHz, 3 
MHz) offered by the V9054 are, also, designated by bandwidth. You may 
choose any one of these filters, or unlike RBWs you may choose to use no 
VBW filter at all. Using the correct VBW, will allow you to clarify your signal 
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or even see a signal you otherwise would not have been able to see because it 
was masked by noise. Below is a diagram displaying a sweep of the same 
signal using two different VBWs. 

Typically the VBW will be controlled automatically by the software using the 
ratio of VBW/RBW size. Setting the VBW/RBW ratio manually allows you to 
maintain a fixed relationship between the filters even when you alter the RBW 
setting. 

30KHz VBW 

J 
Figure 3. Using different VBW filters to smooth displayed noise 

Sweep Time 

The time for the spectrum analyzer to analyze each frequency point from the first to the last 
frequency is called the sweep time, and it is directly affected by three factors, RBW, VBW, and 
synthesizer settling times. The effects of the RBW and VBW settling times will be discussed 
together in the Filters section below because together they determine the second part of the total 
time required by the spectrum analyzer at each frequency. The first part of the total time is the 
synthesizer settling time. 

Synthesizer 

The V9054 uses three Phase Locked Loops (PLLs) and direct digital synthesis 
to tune the V9054 to a particular frequency. The components of the PLLs 
require a certain amount of time to lock at a new frequency. This time is 
called the synthesizer settling time and is approximately 120 microseconds 
(us.) Using this method to tune to a frequency can under certain 
circumstances lead to sweep times that differ from traditional spectrum 
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analyzers, but it also lets the V9054 accurately determine the frequency at 
which a given reading will be performed and to collect points down to 1 Hz 
resolution. 

Filters 

The RBW and VBW filters determine the second delay required at each point. 
That is at each frequency, each filter requires a certain time, settling time, 
before it can be trusted to return accurate data. Both filters may settle 
simultaneously, so the sweep is delayed only by the settling time of the slowest 
filter. For example if the RBW being used has a longer settling time than the 
VBW being used, it is only necessary to wait for the RBW to settle since the 
VBW will be settled before the RBW has finished settling. The settling time of 
a filter is indirectly proportional to the bandwidth of the filter. Thus, the 30 
KHz RBW requires 1110th the settling time of the 3 KHz RBW, and although 
the 300 KHz VBW would require 1110th more time to settle than the 30 KHz 
VBW, it is not true to say that the 300 KHz VBW would require 1110th more 
time than the 30 KHz RBW. Athough the relationship between two RBWs or 
the relationship between two VBWs can be determined by simply evaluating 
the ratio of the bandwidths of the two filters, the same can not be said when 
evaluating RBWs to VBWs. The ratio of RBW to VBW times can be 
determined, from the filter settling data in Appendix A if desired, but it is 
usually sufficient to know that for RBWs and VBWs of equal bandwidth the 
RBW will require more settling time. 

To summarize, given a particular filter combination, the spectrum analyzer 
will require a settling time at each frequency equal to the synthesizer settling 
time plus the largest settling time between the current VBW and RBW. Thus 
if the 3 KHz RBW and the 3 KHz VBW are being used, you know that the 
spectrum analyzer will require the synthesizer settling time plus the settling 
time of the 3 KHz RBW because between RBWs and VBWs of equal size the 
RBW requires the most settling time. If exact settling times are needed they 
can be found in the specifications chapter.. 

Delay Time & Return Data 

The V9054 allows the user to specify that the spectrum analyzer dwell for a certain period of 
time at each point after the spectrum analyzer settles. During the dwell time the spectrum 
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analyzer tracks the minimum and maximum points at that frequency. When the dwell time is set 
to a non zero value, the V9054 may be instructed to return the minimum, maximum, or both the 
minimum and maximum values for each point. 

Detectors 

Based on the nature of your signal you will select either the log detector or the linear detector. 
As their names imply, the log detector returns data on a logarithmic scale, and the linear detector 
returns data on some linear scale. 

Attenuation 

Attenuation reduces the level of the signal entering the V9054. Without the ability to attenuate a 
signal, the V9054 could only examine signals in the range of -120 dBm to -40 dBm, but with 
attenuation this range becomes -120 dBm to +20 dBm. Attenuation accomplishes this by 
shifting the range of the range of the spectrum analyzer, so the difference between the high and 
low ends of the range will always be 80 dBm. Thus, if 25 dB of attenuation is used the 
measurable signal levels will be -95 dBm to -15 dBm. The V9054 can add from 0 to 60 dB of 
attenuation in 1 dB increments for any sweep. 
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VXI Bus Programming 

VXI Programming Libraries 

VXI s o h a r e  standards define the set of VXI Library commands available to the user for low 
level communication with instrument hardware in a VXI chassis. A subset of these commands 
is used by the Morrow Technologies V9054 C Library to implement the V9054 interface through 
an MXI host computer or embedded zero-slot computer interface. National Instruments NI-VXI 
software library is a package which implements the inputloutput functions which "glue"' the 
V9054 C Library interface to the standard VXI command set and bus architecture . This NI-VXI 
software is loaded at run time when the function InitVXIlibrary() is called. The NI- VXI 
software also includes the utility programs VXIINIT.EXE and RESMAN.EXE referred to in this 
document. The Hewlett Packard HP SICL software library fills a similar role. 

Operation 

The VXI architecture is based on a MasterISlave principle. The 
master is called the zero-slot controller because it goes into the left 
most slot of the chassis that is slot number zero. Before accessing 
VXI instruments, a program generally called the resource manager 
(RESMAN.EXE) must be run on the zero-slot controller. Some 
zero-slot controllers require that an additional initialization 
program (VXIINIT.EXE) be run before executing the resource 
manager. The resource manager's job is to locate connected 
devices, collect various data from the devices, determine or assign 
the logical address of each device, and finally initialize each device. 
Some devices will be configured to use a specific logical address 
while others will be configured such that the resource manager 
assigns a specific logical address. Those devices that allow the 
resource manager to configure their logical address are called 
dynamically configured devices. During the assignment of logical 
addresses, the "MODID" LED of each device (if it has one) will 
flash. After assigning the logical address, the resource manager 
sends commands to each device to prepare it for normal operations 
which will cause the access light of each device to flash as it receives 
commands. 

V9054 Register Values 
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The Morrow Technologies V9054 is a Message Based VXI servant device. Some of its VXI 
registers are initialized by hardware on power-up while other registers are initialized by boot 
code in the V9054 static memory. Still other registers are neither used nor initialized and will 
contain unknown values. For each register below there is a list of values which that register may 
hold while the device is operating normally. Additionally, some text is given to describe the 
conditions under which the values appear. 

When first powered up all of the V9054's registers other than OxOA and 0x40 will be in an 
unknown state. OxOA's power-up value is 0x4980, and 0x40's power-up value is 0x2901. The 
initialization code then sets each of the registers to one of the values listed in the table below. 
After the initialization code has run, the value of registers 0x00,0x02,0x08, and 0x40 will not 
change. Any registers not listed in the table below should be considered to be in an unknown 
state at all times. 

Register I Valid Values 
0x00 IOXBECE 

programming. This LED will light when data is read or 
written to the VXI registers present on the Spectrum 
Analyzer. Following the communications protocols listed 
in the Programmer's Guide to the V9054 Spectrum 
Analyzer the Access LED may remain on for long periods 
of time if the V9054 is not responding. This is due to the 
host software continually polling the specturm analyzer f o ~  

0x02 
0x04 

1 a successful error code. 
0x08 1 OxFFFF 

0x0100 
This LED is extremely useful for diagnostics during 

OxOA ~0x4180,0x4380,0x4580,0x4780,0x4980,0x4B80,Ox4D8O,0x4F80 
0x40 1 Ox29Fl. 0x2901 

NOTES: The value of register OxOA is determined by the word serial protocol. For example, 
when the device is not in an error state, ready to receive data, and has no data to send the value 
of the register will be Ox4B80. 

.The value of register 0x04 is determined by the state of the V9054's internal data buffer. 
*Register 0x40 will contain 0x2901 only after a reset but before the initialization code has 
completed. This state can be expected to exist for at most a few microseconds. 

Elementary VXI Programming 
The V9054 C Library is normally used to handle all low level details of operating the V9054. The spectrum analyzer's Get Software Velsion 
Number command will serve as simple example of how to communicate with VXI devices. This command will also verify that the spectrum 
analyzer is receiving and responding to comnmands. If you have already installed the V9054 C Library, you can use its functions to verify the 

instrument. The example below demonstrates direct conununication with the V9054 in case you have not yet installed the library. 

Retrieving the version number from the V9054 requires using the Word Serial Protocol to send three commands to the spectrum analyzer and 
verify each command's response. The commands being sent to the spectrum analyzer will be Abort Normal Operations (value OxCSFF), Begin 

Normal Opeiations (value OxFCFF), and Get Version Number (value Ox7C00.) 
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OUsing the C library word serial command for your platform send OxC8FF to the 
spectrum analyzer and retrieve the command's response. For HP SICL the command is 
"ivxiws" and for NI-VXI the command is "wscmd"; see the documentation on the library 
for your platform concerning the format and usage of the command. 
OA response to step 1 of OxFFFE indicates success. 
OSend OxFCFF to the spectrum analyzer just as OxC8FF in step 1. 
OSuccess is indicated when the lower 8 bits of the upper byte of the response (bits 8-OxB) 
are set. 
OSend Ox7C00 to the spectrum analyzer just as OxC8FF in step 1. 
OThe response to step 5 is the version number currently being used by the processor in 
the V9054 assigned to processing VXI commands (1 of 4 processors.) The lower 4 bits 
of the returned number indicate the minor version number of the software, and the upper 
12 bits reflect the major version number. As of this writing the current version is 1.4, so 
you should have received a response of 0x0014 fiom the spectrum analyzer. 
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Low Level Hardware Programming 

Scope 

This section only applies to programmers attempting to port the V9054 C Library to a new 
architecture. The functions and operations described here are contained within the V9054 C 
Library and involve converting higher level user function calls from the User Function Tree to 
lower level VXI Library command sequences which are compatible with the requirements of the 
V9054 processor interface. The V9054 C Library has a set of functions which do this for the 
National Instruments MXI or embedded VXI interfaces that are hidden from the user unless the 
V9054 C Library source code is purchased. These functions must be changed to accommodate 
other architectures while maintaining V9054 processor communication requirements. 

Outline 

I. The Processors 
11. The V9054 VXI User Defined Commands 
111. Features and Operation 
IV. Brief VXI Word Serial Protocol and Register Tutorial 

I. The Processors 

The V9054 VXI Spectrum Analyzer (hereafter simply "the V9054" ) has two CPUs on board. 
The first processor (designation P 1) controls data collection, and the second processor (P2) 
provides the VXI interface. Two processors were used to simplify the design process. Since a 
single processor spectrum analyzer had already been designed for the PC Bus (the V9052), when 
the V9054 was designed a second processor was added in part to be used as an interface 
mechanism. That is, the second processor was to interpret VXI commands and interpret what 
needs to be sent to the first processor which retains its PC Bus architecture. 

11. The VXP Commands 

Standard Commands 

The V9054 VXI Spectrum Analyzer conforms to all the requirements of a VXI Word Serial 
(WS) Device; in addition to those standard WS commands the device also has 4 user defined 
commands. The operation of each of the user defined commands is explained below. 

User Defined Commands 
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The V9054 VXI Spectrum Analyzer has seven user defined commands as of January 27,1995. 
These seven commands are used to inform P2 to perform some spectrum analyzer specific 
function. Three of the seven functions are used to interface with P 1 which is responsible for data 
collection. Another user defined command is used to determine the software version running on 
P2 and to enable an enhanced mode of operation, and the next command is used to reset the 
spectrum analyzer through software. The last 2 commands are used to program the Flash RAM 
used in P2. The list below shows the command number with its #define name used in the C 
library to abstract the command number into a name. A brief description of the operation of each 
command is also given ( for further explanation see the description of the standard operational 
process.) 

Command# Program Definition and Functional Description 

KU-SETUPFLASH - This command is executed before 
command 0x0009 to setup the flash programming process. If this 
command is not executed or if both commands are not executed 
with the same parameters the flash will not be programmed when 
command 0x0009 is executed. 

W P R O G F L A S H  - This command is executed after command 
0x0008. This command, unlike, command 0x0008 is followed by 
the actual data in the Intel Hex format that you desire to program 
into the flash. The code currently running in P2 has the ability to 
recognize invalid program code but only after the programming 
process is complete. Thus, one should be careful when loading 
code into the processor to avoid accidentally sending the wrong 
file. The processor has a backup in flash which is non-erasable, 
however, and it will use this until proper code is reloaded. The 
non-eraseable code is loaded at the factory however, and 
depending on the age of the spectrum analyzer may lack features 
of newer code. 

KU-RESETENG - Simply put this command will reset both 
processors. However, all VXI setup information will be lost, thus 
you will need to run the Resource Manager after executing this 
command. 

VX-GETVERSION - This command causes P2 to return the 
version # of the software it is currently executing in DataLow, and 
it unlocks a special mode of operation called DataLow Fill Mode 
(DLFM) which is explained later. The format of the 16 bit version 
number should be interpreted as follows: 

bits 0-3 : minor version # 
bits 4-1 5: major version # 

Command# Program Definition and Functional Description 

Ox7D00 KU-ENGINEDATA - When this command is placed into 
DataLow P2 fetches a word of sweep data from (if nothing is 
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available, junk is fetched) the internal FIFO buffer and places it 
into DataLow. 

Ox7EOO VX-GETSTATUS - This command causes P2 to read both the 
FIFO status and the status of P l  and return the result in DataLow. 
The FIFO status is an indication of how much data is waiting to be 
read from the FIFO. The status of P1 changes to 00 if anything 
has been sent to P 1 and stays 00 until P 1 receives a full command. 
P 1 will then put a status value into this register indicating either 
success or the nature of the error. See SA DEFIN.H and 
INTRFACE. C for a list of both the FIFO &d P 1 status values. 

Ox7FOO VXT_ENGINECMD - This command when placed into DataLow 
causes P2 to send the next word placed into DataLow to PI. 

111. Features and Operation 

~ Error Codes 

1 Code (hex) Error Description 

processor has not issued an error code 
success/Acknowlege 
no main code loaded (not valid on P2) 
no DSP code loaded (not valid on P2) 
no Calibration tables loaded (not valid on P2) 
error while trying to erase flash 
error while trying to program memory word 
invalid # of bytes received from hex file 
invalid checksum from hex file 
first char in hex file line not a colon 
bad first parameter (block code in this case) 
bad second parameter (erase code in this case) 

Normal Data Transfer 

Data to and from Processor #2 

Data is transferred to and fiom P2 using the VXI DataLow and Response Registers (see 
section IV.) via the Word Serial Protocol (also described in section IV.) 
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Data to Processor #1 

As in section 1II.B. 1 above the DataLow and Response registers are used to transfer data, 
but additionally, the VXI User Defined Command Ox7F00 must be used. Following the 
Word Serial Protocol, the value Ox7F00 is placed into DataLow. After that value has 
been received by the spectrum analyzer the value being sent to P 1 is placed into 
DataLow. If a response from P1 is desired, one should wait until DataLow is empty and 
then use the VXI User Defined command Ox7E00 which will return the status of P 1 in 
DataLow. It will be noted here that some commands (particularly the flash programming 
commands) may take extremely long times to execute. The commands that are used in 
the course of normal operation (PI command numbers 0-7) are quick, and one can expect 
a response to be available after a few microseconds. 

Data from Processor #1 

It is absolutely essential that before one attempts to read data from P 1 using this method 
that one first checks to see that data is available to be read, for regardless of whether data 
is available something will be returned. Two methods are available for determining if 
data is available from PI. 

The VXI User Defined Command. 

P2's Ox7E00 command returns both P1 error code and the Data FIFO's fill level. 
Bits 8-1 1 in the word returned in DataLow contain the FIFO fill level. Bit 8, 
however, will be 0 if no data is available and set to 1 if anything is available (see 
SA - DEFINH for a complete description of the FIFO fill level bits.) 

The User Defined bits of the Status Register. 

P2 continually monitors the status of the FIFO and places the four FIFO fill level 
bits in bits 4-7 of the VXI Status Register (offset 4 in the register bank.) Reading 
this register is much faster than using the User Defined Command Ox7E00. 
However, the disadvantage to using this method is that the status may not reflect 
the actual FIFO status because R2 does other things in the same loop with 
updating the status; the status lag should not be more than 2 microseconds, if no 
command is sent to P2 while waiting for a status change. 

Once one has established that data is available, the VXI User Defined Command Ox7D00 
is used to tell P2 to grab a word fiom the data FIFO and place it into DataLow. The 
process is quick and only a catastrophic failure will prevent something from appearing in 
DataLow within 8 microseconds. 

High Speed Data Transfer 

Called DataLow Fill Mode or DLFM, when this mode is active, P2 will place any available data 
into DataLow. Additionally P2 will respond to any command it to which it would normally 
respond without losing any data. 
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Entering DLFM 

Set Bit#9 in the Status Register 

Begin Checking Bit#8 in the Status Register, when this bit is Set the request to 
enter DLFM has been acknowledged. 

If this is the first time that DLFM has been turned on, 2 additional steps are 
needed. 

1. Send the VXI command Begin Normal Operations. (see the VXI 
specification for the format and responses of this command.) According 
to the VXI specification a device may not source data into its registers or 
respond to User Defined commands until the device has successfully 
executed this command. However, the Resource Manager normally will 
send the BNO command to all devices when it is executed. If a redundant 
BNO command is executed, the response to the command will indicate 
that is the case. 

2. Send the Getversion user defined command (code Ox7C00) this command 
will source the version number into DataLow (you may discard it if you 
like,) and this command Unlocks Data Low Fill Mode. This is done to 
prevent automatic entry into DLFM after the Begin Normal Operations 
command if the status of the bits in the Status Register happen to be high 
after power on or reset. 

DLFM is now on. Simply check to see if data is available using one of the methods 
described in the Normal Data Transfer, Data from Processor #1 section before reading 
DataLow. This will ensure that data in DataLow is in fact data from P1 rather than a 
response fiom a previous command that was left in DataLow. DLFM and the status 
retrieval method described in III.B.3.b together provide an efficient method to retrieve 
data fiom very fast sweeps. 

Exiting DLFM 

Clear Bit#9 in the Status Register 

Wait for Bit#8 in that same register to be cleared by P2 
DLFM is now off, turning it back on at this stage involves only 1II.C. 1 .a and 
1II.C. 1 .b unless the spectrum analyzer is turned off and reset. 

Initialization 

Operations required to properly initialize the V9054 include the following: 

Bit#9 in the Status Register should be set or cleared to turn DLFM (see 1II.C) on or off as 
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desired. After Bit#9 is in the desired state, the Status Register's Bit#8 should match Bit#9 
within 3 microseconds. Bit#9 functions only as a mechanism to send a request to the 
V9054 to change the current operational mode while Bit#8 reflects the actual mode under 
which the spectrum analyzer operating. 

The VXI Begin Normal Operations (BNO) command should be sent. NOTE: this device 
is incapable of being a VXI commander device, thus the BNO command sent to the 
V9054 should reflect this (see appendix E in the VXI specification). 

The user defined command Ox7C00 should be sent to the V9054. This command will 
unlock DLFM if it was requested in step 1 above, and this command will return the 
current version number of the software executing on P2. It should be verified that the 
version number is correct (currently 1.1 as of 2-1 -95.) The reason for this is that the code 
in the Boot Block will have a version number different from the version number of the 
Main Code Block if new software has been loaded, and if the version number is not that 
of the Main Code Block, features may not be available. 

IV. VXI Word Serial Protocol and Device Tutorial 

For those unacquainted with VXI Word Serial Devices, a brief description of the essential 
concepts and hardware follows. 

The Registers 

Each VXI device has a set of internal 16 bit registers used for data transfer and device 
identification. How these registers appear on the host computer is implementation specific, but 
whether the devices are 110 mapped or memory mapped the registers will always hold the same 
relation to each other. Below, each register will be given a name and an offset from the address 
base, thus, offset 4 (the status register) is the third register ( offset 0 is the first register, offset 2 
the second, offset 4 the third.) Four registers are necessary for the normal operation of the 
V9054 (though more are necessary for the setup process.) 

Status Register - offset 0x04 - bits of interest in this register are: 

Bits#4-7 Data FIFO Fill Level Bits. The exact meaning of 
these bits is described in SA - DEFIN-H, and they are described in 
general in section III.B.3 .a. 

Bit#8 DLFM acknowledge bit (set and cleared by P2) in 
response to Bit#9 below 

Bit#9 DLFM request bit( set and cleared by host to turn 
DLFM on and off 

Response Register - offset OxOA - this register controls handshaking and error 
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notification for Word Serial Protocol. 

Bit#9 Called WriteReady, this bit is high when P2 is ready 
to receive a command or data. 

Bit#lO Called ReadReady, this bit is high when a datum 
has been placed into DataLow (offset OxOE). This datum could 
either be a response from a command which was just placed into 
DataLow (offset OxOE) or it could be data fiom P1 if DLFM is 
active. 

Bit#l 1 Called the ERR* bit, this bit represents in negative 
logic (that's what the * indicates) that an error has occurred. Thus, 
if ERR* = 1 no error has occurred, and conversely if ERR* = 0 an 
error has occurred. The nature of the error can be retrieved using 
the VXI Get Protocol Error command (see appendix E in the VXI 
specification for details.) 

DataLow Register 

Offset OxOE - this register is bi-directional. That is, if the P2 places a datum in DataLow 
and before reading that datum the host writes a command to DataLow the data will not be 
lost because DataLow is actually 2 registers. One of the registers is readable by P2 and 
writeable by the host while the other register is readable by the host and writable by P2. 
Reading and writing to DataLow affects the bits in the Response Register (offset OxOA) 
in the following manners. 

Host Read from DataLow => ReadReady = 0 
Host Write to DataLow => WriteReady = 0 
P2 Write to DataLow => ReadReady = 1 & WriteReady = 1 

Word Serial Protocol 

The foundations for word serial protocol are laid out with the hardware described above. To use 
Word Serial Protocol a device must contain both a Response Register and a DataLow Register. 

Transferring from the host 

When transferring a word fiom the host to the Word Serial Device, the WriteReady and 
ERR* bits are checked. If both bits are high, the value may be placed into DataLow for 
the WS Device, and the host may be assured that the device has received the word when 
WriteReady is high and/or ERR* is low. If ERR* is high and WriteReady is high then 
the it can be assumed that the command was received and executed successfully. If 
ERR* is low an error has occurred and the Read Protocol Error command (see Appendix 
E in the VXI specification) must be used to determine the nature of the error. If a 
suitable period of time elapses WriteReady remains low and ERR* remains high one can 
only assume the device has Failed. 
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Transferring to the host 

Receiving data fiom the device is only possible if ReadReady is high. If ReadReady is 
high, simply read fiom offset OxOE. Host Obligations are as follows: 

The host should never cause the device to source data into DataLow when 
ReadReady is high. This condition is called a Multiple Query Error and it will 
cause the ERR* bit to drop low. 

All VXI commands have a state dependency. The state is based on if the device 
is operating after a Begin Normal Operations command, End Normal Operations 
Command, Abort Normal Operations Command, or a reset. If the BNO command 
has been successfully executed by the device and none of the other commands or 
conditions have occurred the device is said to be in the Normal Operations 
Substate. Typically if the device is not in the Normal Operations Substate it will 
be in the Configure Substate. The VXI specification gives a detailed explanation 
of this and a list of each command's state dependency. It is the host's duty to 
know the state of each of the devices attached to it, and to issue only those 
commands which are valid for the devices current state. 

Device Obligations 

The device may not source a datum into DataLow unless the host has issued a command 
directing the device to do so though a single command is permitted to source more than 
one datum. The important point here is that both the host and device agree on when data 
should cease to be sourced into DataLow. 
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V9054 Specifications 

Filter Settling Times 
( in microseconds ) 

I 1 Settling. Time 1 Settling Time 1 
Filter Size 

3 HZ 
30 HZ 

300 Hz 
3 KHz 

3 MHz I 0.6 I 0.25 I 

RKw 
-NA- 

- 
30 KHz 

300 KHz 
i 

Phase Noise Plot 
9052 PHASE NOISE LIMITS 
(dBc / Hz vs. offset frequency) 

VE~W 

250.000 
-NA- 
6,000 

600 - - -  

60 I 25 
6 2.5 

V9054 VXI SPECTRUM ANALYZER SPECIFICATIONS 

25,000 
2,500 

250 

September 1995 
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RELATED 
FREQuency RANGE 
READOUT ACCURACY 
(Start, stop, center, marker) 

READOUT RESOLUTION 
REF. FREQUENCY temperature 
STABILITY 

REF. FREQUENCY aging 

100 KHz - 1.6 GHz 

+(C. F. x 5x10 -7 + RBW Accuracy + 1025 Hz) 

Option 002 : * (C. F. x 5x10-~ + RBW Accuracy + 103 Hz) 
1 Hz 

5,10-7 
Ontion 002.5x 10-8 

Option 002: + 0.2 PPM 

FM) 
FREQuency STABILITY short term 

Frequency Stability (Hz) (Residual 1 3 KHz RBW: < 100Hz P-P in 100 mS 

2,lo-g per 100 ,S 

PHASE NOISE 
Frequency Span Accuracy 

Option 002: 3 x 10-lo per 100 mS 
< 87 dBc/Hz @ > 30 KHz Offset 

* (Stop Frequency x 5x1 0 -7 + RBW Accuracy + 1025 HZ) 

Resolution Bandwidth Range 
RBW Accuracv 

I REFERENCE LEVEL RANGE 1 -120 dBm to +20 dBm 

Option 002: * (Stop Frequency x 5x10 -8 + RBW Accuracy + 103 Hz) 
300 Hz - 3 MHz 
20% of RBW e x c e ~ t  300 Hz: *100Hz 

L 

RBW Selectivity 60dB /3dB 
VIDEO BANDWIDTH RANGE 

15: 1, 4 Section Synchronous Filter 
3 Hz-3MHz 

I Frequency Response accuracy I +1.0 dB ( 4 . 3 5  GHz) 

Max. Safe Input Power (CW) 
CRT Display Range (LOG) 
Absolute Level Accuracy 

+20 dBm 
1 to 10 dB / div 

< *0.5 dB (-20 dBm input, 100 MHz, -20 dBm reference, 300 Hz RBW, 300 Hz 
VRW) 

(ref. to ~ b s o l u t i  Level Point) - 
Log Maximum Cumulative Error 
RBW Switching Uncertainty 
,STPUT ATTEW-?L4TOR RANGE 

INTERMOD I 
Viewable On Screen I 80 dB 

+1.5 dB (11.35 GHz) 
+ 1.5 dB (0 to -70 dB from reference level) 
+0.5 dB 
0 to 60 dB in 1 dB steps 

Dynamic Range 
COMPRESSION TO NOISE 

Dynamic Range 
SIGNAL TO 3r d order 

l l 0 d B  @300 HzRBW 

>80 dB @ 300 Hz RBW 

RESIDUAL RESPonses 
3rd Order Intermodulation Distortion 

TIME RELATED 
CHARACTERISTIC 
S 

3 1 

< -90 dBm with input terminated, 0 dB attenuation. 
< -70 dBc for two - 30 dBm signals @ mixer 

3rd Order Intercept 
Gain Compression (1 dB) 
Displayed Avg. Noise Level 

+5 dBm 
@Mixer Level = - 10 dBm 
< -120 dBm ( >2 MHz, 300 Hz RBW, 3 Hz VBW, 0 dB attenuation, input terminated ) 
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ACCURACY 
SWEEP TRIGGER MODES 
DIGITIZing RATE 1 x 1 0 ~  Samples/sec. (Max) wI50 MHz sample & hold 

Synthesizer Step Time 
SWEEP TIME ILQJGE (FREQ DISP.) 
SWEEP TIME RANGE (TIME DISP.) 
SWEEP TIME ACCURACY 
MARKER TIME MEAS. ACCURACY 
DELTA MARKER TIME MEAS. 

EXTERNAL INPUT 
CHARACTERISTIC 
S 

< 120 pS 
3.5 mS / Division minimum (auto mode) 
35 pS / Division minimum 
Sweep Time x Reference Accuracy 
Time x Reference Accuracy 
Time x Reference Accuracy 

External Output 
Characteristics 

RF Input 
VSWR 
L.O. Emission 

50 R, SMA female 
< 1.5: 1 typical. (< 1.5 GHz, 210 dl3 input attenuation) 
< 80 dBm (10 dl3 input attenuation) 

External Trigger Input 

I st L.O. Output Level 
VIDEO OUTPUT 

grD I.F. OUTPUT 

+6 dBm 
0 to +I Volt Full Scale 
10.7 MHz @ 0 dBm typical. 

- 

' GENERAL 
SPECIFICATIONS 
POWER REQUIREMENT 
(Maximum) 

WEIGHT 
ENVIRONMENTAL 

CHARACTERISTICS 
Chassis 
VXI Instrument T w e  

September 1995 

6.0 amps @ +5 volts 1.0 amps @ +24 volts 
0.4 amps @ -5.2volts 0.5 amps @ -24 volts (OCXO option only) 
1.50 amps @ +12 volts 
9 Ibs 
0 - SO O C  (chassis), Non-condensing 

VXI "C" size, double wide 
Messape-based 

2 L 

Points per Sweep 
Directed Search Mode 

As it is our intent to continuously improve ourproducts, Morrow Technologies reserves the right to make changes to specifications and features without notice. Mor~ow Technologies, the 

Morrow Technologies logo. Instrument Engines, and the Inshument Engines logo are trademark of Morrow Technologies Corporation. 

~~~ - . ~  a -  

Typically 350 to 10,000 
Sweep with frequency hop table supplied by user 

V9054 Functional Block Diagrams 

81994, 1995, Morrow Technologies Corporation, All Rights Resmed Worldwide 

Artisan Technology Group - Quality Instrumentation ... Guaranteed | (888) 88-SOURCE | www.artisantg.com



Artisan Technology Group - Quality Instrumentation ... Guaranteed | (888) 88-SOURCE | www.artisantg.com



V9054 VXI Spectrum Analyzer Technical Manual 01-12-96 

Receiver Chain Block Diagram 
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Resolution Bandwidth Filters 1 Log Detector Block Diagram 
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Synthesizer Block Diagram 
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Installation Instructions for Front Panel 
Use the following instructions to install your Spectrum Analyzer software. 

1. Remove all older versions of Spectrum Analyzer software from your 
system. Begin by clicking Start>Settings>Control PanebAddtRemove 
Programs. Select and remove any Spectrum Analyzer software from the list 
of programs. 

2. Exit all Windows Programs, and place the installation CD in your CD Drive. 

NOTE: If you do not have a CD ROM drive in your system, you can take the - 
installation CD to a system with a CD ROM drive, then download the program 
from the Diskettes directory to individual diskettes. 

3. Open Windows Explorer, and click your CD drive. The name of the Morrow 
Technologies product-MTC Spectrum displays next to this drive. 

4. In the right navigation pane, double click Setup.exe. The Installation Wizard 
launches followed by the Welcome screen. 

-- 
I n s t a l l i n g  S p e c t  
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Figure 1 .I Welcome Screen 

5. If you have already exited all Windows programs, click Next. The Choose 
Destination Location screen displays. 

NOTE: If you have not exited all Windows programs, click Cancel and please do so 
before proceeding with this installation. 

Figure 1.2 Choose Destination Location Screen 

6. If you want to change the Destination Folder, you can click Browse to 
locate another directory, or click Next to install the program in the default 
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Figure 1.3 

directory C:\Program FilesWTC Spectrum. The Select Components screen 
displays. 

Select Components Screen 

7. From the Select Components screen, a check mark displays next to Front 
Panel by default. You can deselect this option if you choose not to install 
Front Panel. 

Support 
VSA 9085 Interface support for communicating with a VSA 9085 Spectrum Analyzer. 
Support 
Remote Access Interface support for communicating with a Spectrum Analyzer located in a remote 
Support server such as a P9 1 16. 

P - 
I n s t a l l i n g  S p e c t r u m  A n a l y z e r  S o f t w  
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Component Description 
Remote Access Server support for Spectrum Analyzers. 
Server 
Data Logger Server support for Spectrum Analyzers. Collects and logs Spectrum Analyzer data for 

display using one of the log viewer options. 

The information below provides a brief description of various configuration 
choices. 

For a typical Remote-Client System select the following components: 
Front Panel 
Log File Viewer 
Remote Access Support 

For a typical server system using a 9116 select the following components: 
Front Panel 
SA 9052 Support 
Remote Access Server 
Data Logger 

Front Panel 

8. After making your component selections, click Next. The Select Program 
Manager Group screen displays. 
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Figure 1.4 Select Program Manager Group Screen 

9. The default group is MTC Spectrum Analyzer, which appears when you 
click Start>Programs>MTC Spectrum Analyzer. Keep this default 
unless you absolutely must change your Program Manager Group. 

10. Click Next. The Start Installation screen displays. 

Figure 1.5 Start Installation Screen 

11. Click Next to begin the installation. 

m -- 
I n s t a l l i n g  S p e c t r u m  
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Uninstalling Front Panel 
To uninstall Front Panel from your PC: 

Close Front Panel by selecting PanekExit, or clicking the Close button 
in the right corner of the title bar. 

From the Start Menu, select Settings>Control Panel. The Control Panel 
displays. 

Double-click the Addmemove Programs button. 

If necessary, click the Change or Remove Programs button in the left 
pane. 

Scroll through the Currently installed programs list box until Front Panel is 
highlighted. 

Click the Change or Remove button as needed. 

Follow the on-screen prompts. 

In addition to the Front Panel User's Guide and the online Help system, you can 
access Technical Support via E-mail fiom the Morrow Technologies 
Corporation Web site and by regular mail. See below. 

Contacting Morrow Technologies 

Coptact Type Address or Number 
E-mail techsupport@morrow.com 
Web site www.morrowcorp.com 
Telephone (727) 53 1-4000 
Fax (727) 53 1-4026 
Standard US Mail 2300 Tall Pines Drive 

Largo, F133771 

Getting Help 

Using the Help File 

Once you have Front Panel installed, you can use the online Help system at any 
time. To start online Help, select HelpHelp Topics from the Menu Bar, or 
press the <F1> key. 

-- 
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Context Sensitive Help Topics 

You can access context sensitive help topics by clicking the Help 
the toolbar, and clicking a menu item, toolbar button, or program feature. You 
gain access to help for active dialog boxes by pressing <F1> when a dialog box 
is displayed. By highlighting a menu item or toolbar item and pressing <Fl>, 
help displays information on the highlighted item. 
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Tour of the Front Panel Interface 
When you start Front Panel for the first time, the New Spectrum Analyzer 
dialog box displays over the Add Trace dialog box. From the New Spectrum 
Analyzer dialog box, you can assign a name to your Spectrum Analyzer in the 
Local Name For Analyzer field, and select Local or Remote Location. For 
detailed instructions, see "Before starting Front Panel" on page 3-1. 

When you open Front Panel, you start a blank Workspace area. You add a Trace 
Display Panel using Panel on the Menu Bar, and begin by using the Add Trace 
dialog box. For more information, see "Displaying Front Panel" on page 3- 1. 

You can display, hide, minimize, or move most toolbars around on the screen as 
needed. Figure 2.1 illustrates the main workspace for Front Panel with an active 
trace display panel shown. This illustration provides a mini map of the most 
frequently used functions in Front Panel. 

The remaining sections of this chapter provide information about Front Panel 
and Windows features. Subsequent chapters provide information on the use of 
these features. 

-- 
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Figure 2.1 Front Panel Screen with Active Trace Display Panel 
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About the Front Panel Features 

Menu Bar 

The Menu Bar displays two views, Start Up when you first open Front Panel, 
and Active after a Trace Display Panel is displayed. Different menu items 
display depending on whether you are starting Front Panel, or adding a Trace 
Display Panel. Menu items that appear in gray are disabled. 

Figure 2.2 Start Up Menu Bar 

Figure 2.3 Active Menu Bar 

- 
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View Menu 

The View Menu is used to turn Front Panel features on and off. The default 
setting is on, and indicated by the checkmark next to each menu item. By 
selecting each item in the menu list you turn that feature off and its check mark 
disappears. To turn the feature on again, click View on the Menu Bar and select 
the feature. The checkmark reappears and the feature is active again on Front 
Panel. 

Figure 2.4 View Menu 

Toolbar 

The Toolbar displays buttons that when pressed, apply standard Windows and 
frequently used functions in Front Panel. Click any toolbar button to activate its 
function. Buttons displayed in light gray are disabled. 

Figure 2.5 Toolbar 
New Help 

I I 

Add Trace What's This? Help 

Marker Bar 

The Marker Bar accesses many of the same functions used from the pull down 
menus. The icon buttons provide easier access to these functions. Click any 
marker bar button to activate its function. Buttons displayed in light gray are 
disabled. 

Figure 2.6 Marker Bar 
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To Center 

Follow Peak 
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Main Control Bar 

The Main Control Bar provides adjustment options that help you to refine a 
trace. You can use these buttons in lieu of the Control Panel to adjust Center 
Frequency, Span, Reference Level, RBW, VBW, and Select Input. 

Figure 2.7 Main Control Bar 
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Trace Display Panel 

The Trace Display Panel includes the Plot Window, the Annotation Area, and 
the Trace Legend. All spectrum sweeps are traced in the Plot Window. The 
Annotation Area displays current instrument settings, and reflects changes to 
settings when made. The Trace Legend displays a list of information on a single 
trace or on multiple traces. 

Figure 2.8 Trace Display Panel 
1- Annotation Area --1 

L Trace Legend 

Understanding Sweep Time 

Sweep Time is based on the current filter settings and the sweep span. Sweep 
Time (SW) displays in the upper left corner of the Trace Display Panel between 
dBm and Span. 
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Figure 2.9 Sweep Time Between dBm and Span 

NOTE: Limitations in connection bandwidth and workstation performance can cause 
discrepancies between sweep time observed on a trace, and sweep time reported 
in the annotation area of Front Panel. 

Trace Legend 

With Trace Legend, you can view or select multiple traces displayed in the list 
box. For example, from the Toolbar, click the Add Trace button. The Add trace 
dialog box displays. Click the Change button, and select yellow from the basic 
color box, choose OK. 

The Trace Legend adds the second trace below the first trace and displays 
various instrument settings. You can highlight any trace in the legend with one 
click. Double click on any highlighted trace to launch the Configure dialog box. 

Figure 2.10 Trace Legend with Multiple Traces 

Color Instrument Center Freauencv S ~ a n  Ref Level RBW VBW $ 

Control Panel 

You can enter and change parameter values with the Control Panel, and view 
the changes in the Trace Display Panel. You can set Center Frequency, Start 
Frequency, Stop Frequency, Span, and Reference Level from the group of 
buttons at the top. Use the numeric keys to enter numbers in the control panel 
field. Use the unit button to select Hz, kHz, MHz, or GHz. 
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Figure 2.1 1 Control Panel 
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About the Windows Features 

Control Icon and Menu 

The Control icon rn located on the left side of the title bar allows you to gain 
access to the Control menu. You can also double-click this icon to close Front 
Panel. 

The Control Menu provides access to commands you can use to resize or 
reposition Front Panel. Click the Control icon to open this menu. 

Figure 2.12 Control Menu 

Title Bar 

The Front Panel title bar contains the Control icon, the title of the application, 
the name of the active window, and the standard Windows buttons. 

The Trace Display Panel, and all dialog boxes also have title bars. The active 
Trace Display Panel, or Dialog box displays the title of the panel or box. 

-- 
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Double-clicking the program's title bar enlarges the window to full screen. 
Double-clicking the Trace Display Panel's title bar enlarges it to fit the 
workspace. 

Figure 2.1 3 Front Panel Title Bar 

Windows Buttons 

The standard Windows Buttons in the right corner of the title bar are used to 
manipulate the size of the Front Panel window as follows below. 

Minimize I Reduces the size of the 
window, and places it on 
the task bar. 

Maximize 1 Increases the size of the 
window to fill the screen. 

Restore I Return the window to its 
last position, and displays 
only if you activate the 
Minimize or Maximize 
function. 

Close I Closes the window and 
exits the program. 

You can control the Windows Buttons located on the right corner of a Trace 
Display Panel in the same way. 

Works pace 

The Workspace is the area where you display, add, and edit traces in Trace 
Display Panels. See Figure 2.1 on page 2-2 for a mini map of the Workspace 
area. From the Window Menu, you can display multiple trace display panels in 
a variety of ways as follows. 

P W  
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Figure 2.14 Cascade 

Figure 2.15 Tile Horizontal 

-- "-- 

U s e r  G u i d e  

Artisan Technology Group - Quality Instrumentation ... Guaranteed | (888) 88-SOURCE | www.artisantg.com



Figure 2.16 Tile Vertical 

Status Bar 

The Status Bar is located at the bottom edge of the Front Panel window and 
displays details about button functions. You can hover over most buttons on the 
Front Panel window and the status bar lists a description for each button. 

Figure 2.17 Status Bar 

-- 
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Initial Set Up 

Before starting Front Panel 

If you are operating in a network environment, then you must establish network 
communications between your workstation and the spectrum analyzer server. 
Please see your network administrator for assistance. 

Eollow these instructions to display Front Panel. 
-.-~ 

NOTE: The instructions below provide information on gaining access to Front Panel 
from the Windows Start Menu. However, you can also start Front Panel from 
Windows Explorer, or My Computer, then navigate to the MTC Spectrum 
directory, and double click MTCFP.EXE to start the application. 

1. From the Windows Start Menu, select Programs>MTC Spectrum>Front 
Panel. The Front Panel screen displays. 
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Figure 3.1 Front Panel screen 

2. From the Menu Bar, select Panel. 

3. Select New. The New Spectrum Analyzer dialog box displays. 

NOTE: For first time access and to assist with configuration, the New Spectrum 
Analyzer dialog box displays over the Add Trace dialog box. 

Using the New Spectrum Analyzer dialog box 
The first time you access Front Panel the New Spectrum Analyzer dialog box is 
displayed, and from here you can configure the system. You can enter a specific 
name for a new spectrum analyzer, for example TX Site One. You can also 
select Local or Remote location, enter address information, and apply 
Frequency and Amplitude Offsets. You access this dialog box by selecting 
PanePNew from the menu bar. 

Figure 3.2 PanebNew Menu 

---.-. 
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NOTE: You can also access this dialog box by selecting PanebNew from the menu 

bar, and clicking the New button on the Add Trace dialog box. 

Figure 3.3 New Spectrum Analyzer dialog box 

4. In the Local Name for Analyzer field enter a familiar name. For example, 
TX Site One. 

Local Location 

Once you enter a local name for the Spectrum Analyzer, default settings are 
activated. You can establish stand-alone access for the Spectrum Analyzer by 
completing the following steps. 

1. From Address, click the drop down arrow next to Model, and select the 
model number for your instrument. 

NOTE: If you have a model 91 16, select 9052. 

2. Enter the ISA Bus I10 number. The default number is 880. 
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Figure 3.4 New Spectrum Analyzer dialog box for Local Location 

3. Set the Frequency and Amplitude Offsets. 

4. Click OK. 

NOTE: Before selecting OK confirm the connection to the remote analyzer. 

Remote Location 

You can set up your Spectrum Analyzer to accept data from remote locations by 
using the New Spectrum Analyzer dialog box. After you enter a name for a new 
spectrum analyzer use the following instruction for Remote Location set up. 

1. From Location, select Remote. 

2. From Address, enter your host number in the TCPJIP Host field. 

NOTE: To enter a preferred TCPIIP Host name, click the Use Host Name check box, 
and enter your Host name in the TCPIIP Host field. For example, 

- 
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Figure 3.5 New Spectrum Analyzer dialog box for Remote Location 

3. The TCPIIP Port # can be changed. See your system administator. 

4. Set the Frequency and Amplitude Offsets. 

5. Click OK. 

Setting Offsets 

You can apply Offsets for a Spectrum Analyzer from the New Spectrum 
Analyzer dialog box. You can gain access to Offsets whether your instrument is 
set for local or remote location. Use the following instructions to set Offsets. 

1. From Offsets, click the calculator icon next to the Frequency field. The 
built in calculator displays. 

2. Enter the Offset number by clicking the appropriate keys on the built in 
calculator. 

TIP: You can also use your numeric keypad to enter the Offset number. 
PP 

3. Click the drop down arrow next to the units field. 

4. Select the appropriate unit. Choices include Hz, kHz, MHz, and GHz. 

5. Click the calculator icon next to the Amplitude field. The built in calculator 
displays. 

6. Repeat Step 2, and click OK. 

-- 
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Exiting Front Panel 
To exit Front panel use any of the following methods. 

Click the close button .El in the right corner of the title bar 

From the Menu Bar, select PanePExit 

Double-click the Front Panel icon B in the left corner of the title bar 

Select Exit from the Control icon menu 

Press + <F4> 

Artisan Technology Group - Quality Instrumentation ... Guaranteed | (888) 88-SOURCE | www.artisantg.com



Adding a Trace to a Trace Display Panel 
You begin creating a new trace by using the Add Trace dialog box, and then 
adding a Trace Display Panel to the Front Panel workspace. 

Figure 4.1 Add Trace dialog box 

To gain access to the Add Trace dialog box you can: 

Use the Menu Bar and select PanebNew 

Use the New icon on the Menu Bar 

Press Ctrl + N 
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The Add Trace dialog box displays. You use this dialog box to set up a trace. 
Once you set parameters and click OK, the Trace Display Panel appears on the 
workspace. 

Figure 4.2 Trace Display Panel 

When you activate the Add Trace dialog box you can select configured 
spectrum analyzers from the Select Spectrum Analyzer drop down box. You can 
also: 

Choose the New Button to gain access to the New Spectrum Analyzer dialog 
box 

Choose the Edit button to gain access to the Edit Spectrum Analyzer dialog 
box 

Choose the Remove button to delete the selected analyzer in the Select 
Spectrum Analyzer field 

Choose settings from Select Trace Type, and change the trace color by using 
Select Trace Color. 

--- 
NOTE: The New Spectrum Analyzer dialog box and the Edit Spectrum Analyzer dialog 

box function identically. For more information, see "Using the New Spectrum 
Analyzer dialog box" on page 3-2. 

Selecting Trace Type 

There are four option buttons available in the Select Trace Type section of the 
Add Trace dialog box. You make your selection based on the data you want to 
receive on each trace. 
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Figure 4.3 Selecting Trace Type segment ofAdd Trace dialog box 

From each option you can select: 

Actual Value - This is the default setting, and displays the actual trace value 
data 

Maximum Value - Tracks and displays the maximum data value at each 
frequency 

Average Value for last [50] traces - Tracks and displays an average of the 
amplitude at each frequency 

Minimum Value - Tracks and displays the minimum data value at each 
frequency 

Selecting Trace Color 

From the Add Trace dialog box, you can change the trace display color with 
Select Trace Color. The default color is bright green and is displayed in the 
Current Color field. Use the following instructions to change the trace color. 

Figure 4.4 Select Trace Color Segment ofAdd Trace dialog box 

1. Click the Change button. 

2. The standard Windows color selection palette displays. 
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Figure 4.5 

Basic 
Color - 
box 

3. From the Basic Color box, select your preferred color. 

NOTE: You can also create your own custom color using the custom color section of -.-- 
this dialog box. 

4. Click OK. The new color displays in the Current color field on the Add 
Trace dialog box. 

Viewing the Trace Display Panel 
Once you click OK on the Add Trace dialog box the Trace Display Panel 
appears in the Front Panel workspace. 

Figure 4.6 Trace Display Panel 
1- Annotation Area I 

Trace Legend __I 

-,pppr* 
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When a Trace Display Panel displays, you gain access to data from settings 
made during the initial setup process. You can make changes to settings as 
needed by using the Main Control Bar. For detailed instructions on using the 
Main Control Bar, see "Setting Sweep Parameters" on page 6-1. 

Figure 4.7 Main Control Bar 
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You can also make changes to settings by using the Control Panel. For detailed 
instructions on using the Control Panel, see "To set Center Frequency" on 
page 6- 1.  

Figure 4.8 Control Panel 
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Adding a Trace 

When you add a new trace to the active Trace Display Panel, the add trace 
dialogbox displays. You can set display parameters by selecting options in 
Trace Type, see Selecting Trace Type above. You can also change the Trace 
Color, see Selecting Trace Color above.There are two ways you can add a new 
trace to an active Trace Display Panel. To add a new trace you can: 
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Use the Menu Bar and select Trace>Add 

Use the Add Trace icon on the Menu Bar 

Creating Multiple Traces 

Selections made in the add trace dialog box determine how each trace displays. 
You can create up to four traces at a time. Follow these instructions to create 
multiple traces. 

Figure 4.9 Trace Display Panel with Multiple Traces 

Instrument Center Frequency Span 
197 IER d 7n7 115711 11 nn snnnnn 

1. Click PanebNew. The Add Trace dialog box displays with the default 
Actual Value option button selected. 

2. Click OK. The Trace Display Panel displays with a trace representing 
Actual Value. 

3. Click Trace>Add to add another trace. 

4. From the Add Trace dialog box, click the Maximum Value option button. 

NOTE: For viewing ease and trace distinction, it is recommended that you change the 
color of each added trace. To change the trace color, see "Selecting Trace 
Color" on page 4-3. 

5. Click OK. The new trace appears in the Trace Display Panel. 

6. Repeat Steps 3,4, and 5 twice to display traces for Average Value for last 
[50] traces, and Minimum Value trace types. 

-- 
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Using the Trace Menu 
You use the Trace Menu for a variety of functions. 

Figure 4.10 Trace Menu 

You can: 

Add or delete traces 

Save traces, then load them on a Trace Display Panel 

Load saved parameters 

Edit parameters using the Configure dialog box 

Create and save measurement parameters to analyze at a later time 

Set Units Per Division 

Suspend the trace(s) using Hold or Hold All 

Continue trace activity using the Resume trace function 

Deleting Traces 
You can delete a trace on a Trace Display Panel from the Trace Menu. To delete 
a trace: 

1. From the trace legend, highlight the trace you want to delete. 

2. From the Trace Menu, select Delete Trace. 

3. The trace is cleared from the trace display panel. 
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Loading Saved Traces 
You can insert saved trace files (.trc) on an active Trace display Panel using the 
Trace Menu. Follow these instructions to load saved traces. 

1. From the Trace Menu, select Load. 

2. The Load Trace Data From dialog box displays. 

Figure 4.1 1 The Load Trace Data From dialog box 

3. Select a saved trace (.trc files) from a directory of your choice. 

4. Click 0pen.The loaded trace remains fixed, while the active trace continues 
scanning. The saved trace file and settings appear in the Trace Legend 
section at the bottom of the Trace Display Panel (see Figure 4-2). Saved 
traces are obtained by using Trace>Save As. For more information, see 
Saving Traces. 

Saving Traces 

You can create a trace file (.kc) and save it in a directory of your choice. Follow 
these instructions to create and save traces. 

1. From the Trace Menu, select Save As. 

2. The Save Trace Data As dialog box displays. 

""-. 
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Figure 4.12 The Save Trace Data As dialog box 

3. Navigate to a directory of your choice. 

4. In the File Name field, name the file and add a Arc extension. 

5. Click Save to save the file. 

To load a trace on an active Trace Display Panel use TraceBLoad. For more 
information, see "Loading Saved Traces" on page 4-8. 

Loading Parameters 
You can load measurement parameters that you saved using the Save 
Parameters As dialog box. To load parameters: 

1. From the Trace Menu, select Load Parameters. The Load Parameter From 
dialog box displays. 

Figure 4.13 Load Parameters From dialog box 

2. Navigate to the saved parameter file of your choice. 
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3. Select the saved parameter file, and click Open. The saved parameter file 
displays on the Trace Display Panel. 

Editing Parameters 

From the Trace Menu, you can access the Configure dialog box and edit 
parameters. To edit parameters: 

1. From the Trace Menu, select Edit Parameters. The Configure dialog box 
displays. See, "Using Configure" on page 8-1 

2. Select the desired tab and set the new parameters. 

Saving Parameters 

You can create and save measurement parameters to use at a later time. To save 
measurement parameters: 

1. From the trace menu, select Save Parameters. The Save Parameters As 
dialog box displays. 

Figure 4.14 Save Parameters As dialog box 

Support 

Testsequence 
noeefloor.prm 

phasenoise.prm 

rpec.prrn 

NOTE: From the navigation area, you can select a directory of choice and save your 
parameters. 

2. In the File Name field, enter the name of the file. For example, test.prm. 

3. Click Save to save the file. 

Set Units Per Division 

You can select Set Units Per Division to zoom in to a trace without changing the 
frequency range. Follow these instructions to Set Units Per Division. 

1. From the Trace Menu, select Set Units / Div. 
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2. The Set Units Per Division dialog box displays. 

Figure 4.15 The Set Units / Div dialog box 

r Apply to all traces check box 

Built in calculator Set button 

3. Click the built in calculator and select the number of units for each grid cell. 

4. For multiple traces, click Apply to all traces in view check box. 

5. Click Set. 

Results 

The following illustrations show the difference between 20 and 30 Units per 
Division. 

Figure 4.16 At 20 dBm 

Figure 4.17 At 30 dBm 

You can use Hold/Resume to hold a trace in a current state on a Trace Display 
Panel. All other traces continuously update while the spectrum analyzer is 
sweeping, but the held trace remains unchanged until Resume is selected. 
Follow these instructions to use Hold/Resume. 
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1. From the Trace Legend, click to highlight the trace you want to hold. 

Figure 4.18 Trace Legend with Multiple Traces 

2. From the Trace Menu, select Hold.The highlighted trace freezes, and Hold 
switches to Resume on the Trace menu. 

3. To continue a trace, select Resume. 

Hold AlllResume All 

You can use Hold AlIResume All to freeze one or more traces simultaneously 
on a Trace Display Panel. Follow these instructions to use Hold AlVResume 
All. 

1. From the Trace Menu, select Hold All. The trace(s) freezes on the Trace 
Display Panel. 

2. To continue the sweep of a trace(s), select Resume All from the Trace 
Menu. 

c t r u m  A n a l y s i s  U s e r  G u i d e  
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Editing Global Preferences 
From the Tools Menu, you gain access to the Edit Global Preferences dialog 
box. Follow these instructions to Edit Global Preferences. 

1. From the Tools Menu, select Tools>Preferences. The Edit Global 
Preferences dialog box displays. 

Figure 5.1 Edit Global Preferences dialog box 

Choose Frequency Mode 
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2. From the Frequency Mode, choose CenterISpan or StartIStop. 
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3. From the Step Sizes section, you can set steps by clicking the built in 
, then enter the number of increments. 

TIP: You can also click any field in this section and enter numbers using the keypad 
on your keyboard. 

NOTE: These step sizes affect the active Trace Display Panel. To view the results, click 
OK after you enter numbers, then click the blue arrows next to the CF, 
SP, or RL buttons on the Main Control Bar. 

Figure 5.2 Main Control Bar 

4. Click the drop down arrows next to the Units field to set units. Choices 
include Hz, KHz, MHz, GHz. 

5. To set units per division for future traces use the UnitsIDivision section. See 
the NOTE below. 

NOTE: To change Units Per Division for the active Trace Display Panel use Trace>Set 
UnitsIDivision from the Menu Bar. 

Figure 5.3 Menu Bar 
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Setting Center Frequency 
You can set the Center Frequency and Span on the Spectrum Analyzer from the 
Control Panel. Follow these instructions to accomplish this task. 

To set Center Frequency 
1. From the top of the Control Panel, press the Center Frequency button. 

Figure 6.1 Control Panel 

Settings 
buttons- 

Numeric 
keys - 

Control 
- Panel 
field 

Unit 
'buttons 

2. From the numeric keypad, enter the center frequency number you want to 
analyze. The numbers you select display in the Control Panel field. 
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TIP: You can click in the Control Panel field and enter numbers using; the numeric 
P 

keypad on your keyboard. 

3. From the Unit buttons, click the desired unit. Choices include, Hz, kHz, 
MHz, and GHz. 

To set Center Frequency using the Main Control Bar 

button on the Main Control Bar. 

2. The Set Center Frequency dialog box displays. 

Figure 6.2 Set Center Frequency 

3. Click the built in calculator and enter a new Center Frequency. 

4. Click the drop down arrow next to the unit field and adjust as needed. 

5. Click Set to set the new Center Frequency. 
-"-"--- 

NOTE: Once set, you can increase or decrease the Center Frequency by an increment of 
one using the blue arrows to the right and left of the CF button. 

Setting Span 

To set Span using the Control Panel 

1. From the top of the Control Panel, press the Span button. 

2. From the numeric keypad, enter the number of the Span you want to 
analyze. The numbers you select display in the Control Panel field. 

TIP: You can click in the Control Panel field and enter numbers using the numeric 
keypad on your keyboard. 

3. From the Unit buttons, click the desired unit. Choice include Hz, kHz, MHz, 
and GHz. 

To set Span using the Main Control Bar 

1. Click the @ button on the Main Control Bar. 

2. The Set Frequency Span dialog box displays. 

- 
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Figure 6.3 Set Frequency Span 

3. Click the built in calculator and enter a new Frequency Span. 

4. Click the drop down arrow next to the unit field and adjust as needed. 

5. Click Set to set the new Frequency Span. 
- 

NOTE: Once set, you can increase or decrease the Span by an increment of one using 
the blue arrows to the right and left of the SP button. 

Setting StarUStop Frequency 

To set Start Frequency 
You can set the StartIStop Frequency on the spectrum analyzer from the Control 
Panel. Follow these instructions to accomplish this task. 

1. From the top of the Control Panel, press the Start Frequency button. 

2. From the numeric keypad, enter the first number of the frequency you want 
to analyze. The numbers you select display in the Control Panel field. 

TIP: You can click in the Control Panel field and enter numbers using the numeric 
keypad on your keyboard. 

3. From the Unit button, click the desired unit. Choices include Hz, kHz, MHz, 
and GHz. 

To set Stop Frequency 

1. From the top of the Control panel, press the Stop Frequency button. 

2. From the numeric keypad, enter the last number of the frequency you want 
to analyze. The numbers you select display in the Control Panel field. 

- TIP: You can click in the Control Panel field and enter numbers using the numeric 
keypad on your keyboard. 

3. From the Unit button, click the desired unit. Choices include Hz, kHz, MHz, 
and GHz. 
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Setting the Reference Level 
You can set the Reference Level on the Spectrum Analyzer from the Control 
Panel. Follow these instructions to accomplish this task. 

To set the Reference Level 

1. From the top of the Control Panel, press the Reference Level button. 

2. From the numeric keypad, enter the Reference Level you want to view. The 
numbers you select display in the Control Panel field. 

TIP: You can click in the Control Panel field and enter numbers using the numeric 
keypad on your keyboard. 

3. From the Unit buttons, click the desired unit. Choices include, Hz, kHz, 
MHz, and GHz. 

To set Reference Level using the Main Control Bar 

1. Click the 'a button on the Main Control Bar. 

2. The Set Reference Level dialog box displays. 

Figure 6.4 Set Reference Level 

3. Click the built in calculator and enter a new Reference Level. 

4. Click the drop down arrow next to the unit field and adjust as needed. 

5. Click Set to set the new Reference Level. 

NOTE: Once set, you can increase or decrease the Reference Level by an increment of 
10 using the blue arrows to the right and left of the RL button. 

Setting RBW and VBW 
You can set the Resolution Bandwidth Filter (RBW) and the Video Bandwidth 
Filter (VBW) from the Main Control Bar. Follow these instructions to 
accomplish this task. 

- --"---. 
6-4 S p e c t r u m  A n a l y s i s  U s e r  G u i d e  

Artisan Technology Group - Quality Instrumentation ... Guaranteed | (888) 88-SOURCE | www.artisantg.com



To set the RBW 
1. From the Main Control Bar, press the RBW button. The RBW drop down 

menu displays. 

Figure 6.5 RB W drop down menu 

2. Select the appropriate Resolution Bandwidth Filter from this list. 

To set the VBW 
1. From the Main Control Bar, press the VBW button. The VBW drop down 

menu displays. 

Figure 6.6 VB W drop down menu 

2. Select the appropriate Video Bandwidth Filter from this list. 

Using Select lnput 
You choose Select Input if your server is configured for multiple inputs. Follow 
these instructions to accomplish this task. 

To set Select lnput 
1. Click the Select Input button on the Main Control Bar. 

2. The Select Input drop down menu displays. 
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Figure 6.7 Select Input drop down menu 

3. Select fiom 1 to 4 to gain access to each input. 

PUMP- 

n a l y s i s  U s e r  G u i d e  
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WORKING WITH MARKERS 

Activating a Point Marker 
Point Markers affect the active trace display panel on top. Follow these 
instructions to activate a Point Marker. 

To activate a Point Marker 
1. Click Markers on the Menu Bar. The Marker pull down menu displays. 

Figure 7.1 Marker Pull Down Menu 

2. Point to Point Marker A or Point Marker B. The Marker pull down 
secondary menu displays to the right. 
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Figure 7.2 Marker Pull Down Secondary Menu 

3. Click Attach. A diamond peak Marker displays in the active trace display 
panel on the left. 

Figure 7.3 Diamond Peak Marker 

From the Marker Bar 

You can also attach a Point Marker using the Marker Bar. Follow these 
instructions to accomplish this task. 

Figure 7.4 Marker Bar 

Markers A or B Peak Functions Measure Functions 

Switch Line Markers To Reference Level Noise Suppression 
To Center 

Follow Peak 
Track Peak to Center 

1. From the Marker Bar, click the Switch button. The Marker drop down box 
displays. 
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Figure 7.5 Switch button and Marker drop down box 

2. Select Point Marker A or Point Marker B. 

3. A diamond peak Marker displays on the left of the trace display panel, and 
button is highlighted on the Marker Bar. 

-- 
NOTE: You can remove a marker by selecting Point Marker A or B again from the 

Switch>Marker drop down box. 

Activating a Line Marker 
Line Markers affect the active trace display panel on top of the workspace. 
Follow these instructions to activate a Line Marker. 

To activate a Line Marker 
1. Click Markers on the Menu Bar. The Marker pull down menu displays. 

Figure 7.6 Marker Pull Down Menu 

2. Point to Line Marker 1 or Line Marker 2. The Marker pull down menu 
displays to the right. 
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Figure 7.7 Marker Secondary Pull Down Menu 

3. Click Attach. A solid horizontal line Marker displays when you select Line 
Marker 1. A dashed horizontal line Marker displays when you select Line 
Marker 2. 

From the Marker Bar 

You can also attach a Line Marker using the Marker Bar. Follow these 
instructions to accomplish this task. 

1. From the Marker Bar, click the Switch button. The Marker drop down box 
displays. 

Figure 7.8 Switch and Marker Drop Down box 

2. Select Line Marker 1 or Line Marker 2. 

3. A solid horizontal line displays when you select Line Marker 1. A dashed 
horizontal line displays when you select Line Marker 2. 

NOTE: You can remove a line marker by selecting Line Marker 1 or 2 again from the - - 
Switch>Marker drop down box. 

Using Point and Line Markers 
There are several ways you can manage Markers on the trace display panel. 

--- 
i s  U s e r  G u i d e  
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You can: 

Drag and Drop the Marker(s) directly on the Trace Display Panel 

Use the Marker Bar 

Use the Menu Bar 

Drag and Drop For Point or Line Markers 

I. Click the Point or Line Marker with the left mouse button. 

2. Hold the left mouse button down and drag the Marker to the desired peak. 

3. Release the mouse button, and the Marker anchors to the desired peak. 

Use the Marker Bar 

After activating a Point Marker you must press the , or @ button to start 
other functions on the Marker Bar. 

From the Marker Bar you can click the: 

@ button to move a Marker left to the next peak. 

. button to move a Marker to the highest level in a sweep. 

button to move a Marker to the next highest peak. 

. button to move a Marker right to the next peak. 

@ button to set the reference level to the Marker amplitude. 

. button to set center frequency to the Marker frequency. 

button to set the instrument to Follow a signal. Follow automatically 
maintains the Marker on a moving peak. 

@ button to set the instrument to Track a signal. Track automatically 
adjusts the center frequency to maintain the selected peak at the center 
of the screen. 

@ button to move Point Markers 3 dB lower than the current peak. 

@ button to move Point Markers 6 dB lower than the current peak. 

button to move Point Markers 60 dB lower than the current peak. 

button to compute the power between Point Markers A and B. The 
Mkr Pwr computation displays to the right of the grid on the Trace 
Display Panel. 
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. button to compute 99% of the power bandwidth between Point 
Markers A and B. The Pwr BW computation displays to the right of 
the grid on the Trace Display Panel. . button to activate Marker Noise Mode. By using Marker Noise the 
Marker readout is normalized to a 1 dB bandwidth, specifically units 
of dBm/Hz. An "N" displays at the bottom of the trace display panel 
indicating activated Marker Noise. 

Use the Menu Bar 
From the Menu Bar point to Markerepoint Marker A or B. The secondary 
menu displays and you can: 

Figure 7.9 Markers Full Menu 

Add or remove Markers by selecting Attach or Detach 

Move a Marker left to the next peak by selecting Next Peak Left 

Move a Marker to the highest level in a sweep by selecting Peak Search 

Move a Marker to the next highest peak by selecting Next Peak 

Move a Marker right to the next peak by selecting Next Peak Right 

Make the center frequency equal to a Point Marker frequency by selecting 
To Center 

Set the reference level to the Marker amplitude by selecting To Reference 
Level 

Set the instrument to follow a signal by selecting Follow Peak 

Set the instrument to track a signal by selecting Track Peak 

Set the instrument to activate noise suppression by selecting Noise 

-- 
A n a l y s i s  U s e r  G u i d e  

Artisan Technology Group - Quality Instrumentation ... Guaranteed | (888) 88-SOURCE | www.artisantg.com



Use the Marker Bar for Line Markers 
After activating a Line Marker, you must press the , or 8 button to start 
other functions on the Marker Bar. 

From the Marker Bar you can click the: 

button to move a Marker lefi to the next peak. 

1 button to move a Marker to the highest level in a sweep. 

button to move a Marker to the next highest peak. 

a button to move a Marker right to the next peak. 

Use the Menu Bar for Line Markers 
From the Line Marker Menu Bar you can: 

Figure 7.10 Line Markers Full Menu 

Attach or detach Markers by selecting Attach or Detach 

Move a Marker lefi to the next peak by selecting Next Peak Left 

Move a Marker to the highest level in a sweep by selecting Peak Search 

Move a Marker to the next highest peak by selecting Next Peak 

Move a Marker right to the next peak by selecting Next Peak Right 

Working with Measure Functions 

Using Bandwidth Markers 
From the Markers menu, you can select 3 dB, 6 dB, or 60 dB bandwidth 
markers. Point Markers are placed on each side of the current frequency at 3,6, 
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or 60 dB lower than the current peak. Follow these instructions to activate 
bandwidth markers. 

To activate Bandwidth Markers 

1. From the Markers menu measure functions segment, point to 3 dB, 6 dB, or 
60 dB Bandwidth. 

Figure 7.1 1 Measure Functions segment of Markers Menu 

2. Point Markers are displayed on a sweep at frequencies lower than the 
current peak. 

3. To disable Bandwidth Markers select Markerepoint  MarkerA>Detach, 
then Markers>Point Marker B>Detach. 

Using Marker Power 

You can use Marker Power to compute the power between Point Markers A and 
B of a 3 dB, 6 dB, or 60 dB Bandwidth measurement. Follow these instructions 
to activate Marker Power. 

To activate Marker Power 

1. From the Markers menu measure functions segment, choose 3 dB, 6 dB, or 
60 dB Bandwidth. (See Figure 7.1 1). 

2. Select the Markers menu again and point to Marker Power. 
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Figure 7.12 Markers Menu>Marker Power 

3. The Mkr Pwr computation displays to the right of the grid on the Trace 
Display Panel. 

Figure 7.13 Mkr Pwr Computation 

4. Point to and select Marker Power again to disable Marker Power. 

Using Power Bandwidth 

You can use Power Bandwidth to compute the occupied bandwidth between 
Point Markers A and B of a 3 dB, 6 dB, or 60 dB Bandwidth measurement. 
Follow these instructions to activate Power Bandwidth. 

To activate Power Bandwidth 

1. From the Markers menu measure functions segment, choose 3 dB, 6dB, or 
60 dB Bandwidth. (See Figure 7.1 1). 

2. Select the Markers menu again and point to Power Bandwidth. 
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Figure 7.14 

3. The Pwr BW computation displays to the right of the grid on the Trace 
Display Panel. 

Figure 7.15 Pwr BW Computation 

4. Point to and select Power Bandwidth again to disable Power Bandwidth. 

Setting Threshold 

You can limit your Point Markers to values above the instrument's noise floor 
by selecting Set Threshold from the Markers menu. Follow these instructions to 
activate Set Threshold. 

To activate Set Threshold 

1. Activate a Point Marker, or select a measure function. For more 
information, see "Activating a Point Marker" on page 7-1. 

2. From the Markers menu, choose Set Threshold. 
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Figure 7.16 Markers>Set Threshold 

3. The Set Marker Threshold dialog box displays. 

Figure 7.17 Set Marker Threshold dialog box 

Click Set button 1 

Built in ~ a l c u l a t o 4  

4. Click the calculator icon. The built in calculator displays. 

Figure 7.18 Calculator 

Calculator icon 
I 

5. Enter the Marker Threshold number by clicking the appropriate keys on the 
calculator. 

NOTE: The default setting is 6 dB. 

6. Click the Set button. 

NOTE: To view the Threshold you've set, use the peak left (PL) or peak right (PR) 
buttons on the Marker Bar to move the Marker on the trace until it stops. 

W o r k i n g  
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Accessing Configure 
From the Configure dialog box you have a variety of adjustment capabilities for 
each trace. Five separate tabs provide adjustment options for the following 
functions: Frequency, Amplitude, Filters, Trigger, and Custom. You can access 
the Configure dialog box from the Menu Bar. Follow these instructions to 
complete this task. 

1. From the Menu Bar, click Trace>Edit Parameters. 

Figure 8.1 Trace drop down menu 

2. The Configure dialog box displays. Click each tab to view all available 
options and make changes as needed. 
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Figure 8.2 Configure dialog box 

You can also access the Configure dialog box by double clicking any 
highlighted trace on the Trace Legend. 

Figure 8.3 Trace Legend with Multiple Trace 

Instrument Center Frequency Span Ref Level 
38.1 83.1 31.202 8521 28920 2000000 -30 

I I . , 
s o  : : ' I  I I I I I I  

Configuring Frequency 
From the Frequency tab, you can change the current frequency by selecting the 
option button for CenterISpan or StartIStop Mode. Follow these instructions to 
complete this task. 

1. From the Menu Bar, click Trace>Edit Parameters. 
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Figure 8.4 

2. The Configure dialog box displays. 

Figure 8.5 Configure dialog box 

3. From the Frequency tab, click the built in calculator and enter a new 
frequency. 

4. Click the equal sign to set the new frequency. 

5. Click the pull down arrow and select the appropriate unit from the drop 
down list. 

6. Click Apply, and then click OK. 

7. To select Full Span, click the button. 
P 

NOTE: You can gain access to the Configure dialog box by double clicking a 
highlighted trace on the Trace Legend. 
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Configuring Amplitude 
From the Amplitude tab, you can set the Log or Linear Detector, set the 
Reference Level and Unit, or establish Data Collection Parameters. Follow 
these instructions to accomplish this task. 

1. From the Menu Bar, click Trace>Edit Parameters. 
Figure 8.6 

2. The Configure dialog box displays.Click the Amplitude tab. 

Figure 8.7 

3. From the Detector pull down arrow, select Log or Linear. 

8-4 S p e c t r u m  A n a l y s i s  U s e r  G u i d e  

Artisan Technology Group - Quality Instrumentation ... Guaranteed | (888) 88-SOURCE | www.artisantg.com



Figure 8.8 Log Detector selected 

Drop down arrow 

~ o d e r  units 

Figure 8.9 Linear Detector selected 

Dror, down arrow 

~ikear units 

Click the built in calculator a and enter the Reference Level for the Log or 
Linear Detector. 

Click the equal sign to set the Reference Level. 

Click the pull down arrow and select the appropriate unit from the drop 
down list. 

From Data Collection, select the option button for Maximum or Minimum 
Amplitudes, or disable these settings by clicking the Disable Cell Mode 
check box. 

Figure 8.10 Data Collection segment ofAmplitude Tab 

L &led Maximum 
or Minimum AmplRudes 
option butkons 

8. Click Apply, and click OK. 
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-- NOTE: You can gain access to the Configure dialog box by double clicking a 
highlighted trace on the Trace Legend. 

Configuring Filters 
From the Filters tab, you can configure the system to automatically set the RBW 
and VBW filters. Follow these instructions to complete this task. 

Figure 8.1 1 RB W/VB WJilters tab 

1. From the Menu Bar, click Trace>Edit Parameters. 

Figure 8.12 

2. The Configure dialog box displays. Click the Filters tab. 
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Figure 8.13 

3. Click the check box next to Auto in the Resolution Bandwidth box. 

4. Click the check box next to Auto in the Video Bandwidth box.This action 
disables the units field and enables the RBWNBW Ratio field. 

5. Set the RBWNBW Ratio by clicking in the field and entering a number 
from your numeric keypad. 

6. Click Apply, and then click. 

NOTE: You can gain access to the Configure dialog box by double clicking a - - 
highlighted trace on the Trace ~egend.  

Configuring Trigger 
From the Trigger tab, you can configure the system to control how sweeps begin 
and proceed. Follow these instructions to complete this task. 

1. From the Menu Bar, click Trace>Edit Parameters. 

- 
U s i n g  C o n f i g u r e  
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Figure 8.14 

2. The Configure dialog box displays. Click the Trigger tab. 

Figure 8.15 

3. Click the check box next to Enable, and then select the appropriate option 
button for Mode or Type. 

4. From Mode, click the Once, or Every Sweep option button. 

5. From Type, you can select Edge>Rising or Edge>Falling by selecting the 
appropriate option button. 

6. From Type, you can select LevebHigh or LevebLow by selecting the 
appropriate option button. 

7. From Type, select the Video option button, and set the Frequency, 
Amplitude, units, and dBm by using the built in calculator and drop down 
list. 

-- 
p e c t r u m  A n a l y s i s  U s e r  G u i d e  
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8. From Type, you can select the Manual option button to disable all other 
functions in Type. 

9. From Trigger Delay, you can use the built in calculator to set the amount of 
time for the delay, and use the drop down list to select the seconds. 

NOTE: You can gain access to the Configure dialog box by double clicking a 
highlighted trace on the Trace Legend. 

U s i n g  C o n f i g u r e  
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A 
Active Menu Bar 

Actual Value 

Add Trace 

Annotation Area 

Attach 

Average Value 

B 
Basic Color Box 

C 
Center Frequency 

Color Selection Palette 

Configure 

Control Panel 

D 
Data Collection Parame- 
ters 

Edit Global Preferences 

Glossary 

Displays after a new Trace Display Panel is displayed in the Front Panel 
Workspace. 

A trace type that displays the actual trace value data. 

Dialog box used to add extra traces to a Trace Display Panel. 

A section of the Trace Display Panel that displays current instrument settings 
and reflects changes to settings when made. 

Command used to attach a Point or Line Marker to a Trace Display Panel. 

A trace type that tracks and displays an average of the amplitude at each 
frequency. 

Use to change the color of traces added to a Trace Display Panel. You gain 
access to the Basic Color Box fiom the Add Trace dialog box. 

The frequency that exists in the center of a sweep. 

Use to change the color of additional traces, and accessed through the Add Trace 
dialog box. Contains standard Windows colors. 

Dialog box used to configure the specturm analyzer. With this dialog box you 
can configure frequency, reference level, filters, trigger, and custom. 

The group of control buttons located on the right side of the workspace. Use to 
enter and change parameter values. 

Use to set parameters for collection of minimum or maximum amplitude 
readings, or disable cell mode. You can gain access from the Configure dialog 
box, Amplitude tab. 

Use to set step sizes globally for Center Frequency, Span, Reference Level, and 
Units per Division. 
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Edit Parameters Use to change parameter settings. When you access Edit Parameters from the 
Trace Menu, the Configure dialog box displays. 

Edit Spectrum Analyzer Use to edit information about the spectrum analyzer. You can gain access from 
the Add Trace dialog box, Edit. button. 

F 
Filters Use to automaticaly configure the RBW and VBW filters. You can gain access 

fromt the Configure dialog box, Filters tab. 

Front Panel Morrow Technologies latest innovation in Spectrum Analysis software. 

Full Span 

L 
Line Marker 

Linear Detector 

Load Parameters 

Log Detector 

Use to display the entire span of the Spectrum Analyzer. You can gain access 
from the Trace Menu>Edit Parameters>Frequency tab, and click the Full Span 
button. 

Use to activate a solid or dashed horizontal line on the Trace Display Panel. You 
gain access from the Markers Menu. 

Returns Data on a linear scale. 

Use to load measurement parameter files you saved using the Save Parameters 
As dialog box. You can gain access from the Trace Menu. 

Returns data on a logarithmic scale. 

M 
Maximum Value Tracks and displays the maximum data value at each frequency. You can gain 

access from the Add Trace dialog box. 

Minimum Value Tracks and displays the minimum data value at each frequency. You can gain 
access from the Add Trace dialog box. 

N 
New Spectrum Analyzer Dialog box. Use to set up a new spectrum analyzer. You can gain access from 

the Add Trace dialog box by clicking the New button after the system is 
configured. 
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P 
Point Marker 

R 
RBW 

S 
Set Units Per Division 

Span 

Start Frequency 

Stop Frequency 

v 
VBW 

Use to activate a diamond peak marker on the Trace Display Panel. You can gain 
access from the Markers Menu. 

Resolution Bandwidth Filter. A bandwidth dependent filter used to resolve 
individual signals. The narrower the RBW the more noticeable the separation of 
two signals. 

Trace Menu item used to establish the amplitude units represented by each grid 
cell on a Trace Display Panel. 

The width of the frequency range being examined. 

The first frequency setting in a sweep. You can establish this setting from the 
Control Panel. 

The last frequency setting in a sweep. You can establish this setting from the 
Control Panel. 

Video Bandwidth Filter. Used to reduce or eliminate noise of the signal. 
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Welcome to Switch Support 

I Configuring the Parallel Port Through the Device Manager 

For use with models 9052 and 91 16 server configurations. Use the following instructions to configure 
the parallel port using the Windows Device Manager. Screen shots taken from Windows 2000. 

1. From the desktop, right-click My Computer and choose Properties. The System Properties dialog 
box displays. 

2. From the System Properties dialog box choose the Hardware tab. 

3. From the Hardware 
displays. 

tab, choose the Device Manager button. The 

, ~-p&~a~~&:(i~qy . \ *.e*u l d  

Device Manager dialog box 

@ Copyright 2002 Document #2002-027 
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~EI a Computer . - 

Floppy diskcontrollers 
- 5 3  Floppy diskdrives 

2 Setting The Port 

You can set the port using the Device Manager dialog. 

1. From the Device Manager dialog box, click the plus sign next to Ports. 

@I - 3 Ports (COM & LPT) 

2. From the drop down list, double-click Printer Port (LPTI). The ECP Printer Port Properties dialog 
box displays. 

h-- a Ports (COM ~ L P T )  
: -: ; : -9 Communications Port (COM1) 
; :.,. 3- 
: - 
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3. From the ECP Printer Port Properties dialog box, click the Resources tab. 

~ l n p u t l O u t p u t  Range 0378 - 037F 
mInput/Oulput Range 0778 - 077F 

Direct Memory Access 03 

From the Use automatic settings check box, click to remove the check mark. This action activates 
the Setting based on field, and the Change Setting button. 

Click the drop down arrow zd and choose Basic Configuration 0001 from the list. 

From the Resource settings field, click lnterrupt Request. 

Click the Change Settings button. The Edit lnterrupt Request dialog box displays. 
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8. Click the up arrow to change the Value to 07. 

9. Click OK. 

I Installing Switch Support 

Follow these instructions to setup the instrument with correct switch support. 

Renaming the Current Service File 

1, Install the Front Panel software. For more information see, the Spectrum Analyzer Installation 
Guide. The default folder created is C:\Program Files\MTCSpectrum. 

2. Navigate to C:\Program Files\MTCSpectrum. 

3. Double-click the MTCSpectrum folder to open. 

4. Choose the MTCISASvc.exe file, right-click and choose Rename. 

5. Rename this file MTCISASvcNoswitch. 

Creating the New Sewice File with Coax Switch Capability 

I. From the Front Panel installation CD, select the MTCISASvc4p.exe file. 

2. Choose Edit>Copy. 

3. From Windows Explorer, open the MTCSpectrum folder. 

4. Choose Edit>Paste. 

5. Right-click the MTCISASvc4p.exe file and choose Rename. 

6. Rename this file to MTCISASvc.exe 

7. Delete the MTClSASvcNoswitch file. 

8. Restart the computer. 
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